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Notice 
NORBIT makes every effort to provide the latest 
technical documentation. There may be updates. 
Contact NORBIT Support for the most recent 
version. 
 

Copyright Statement 
Copyright © 2026 NORBIT. All rights reserved. 
This publication may not be copied, translated, 
reproduced or transmitted in any electronic form 
without prior written consent from NORBIT. 
 

Disclaimer 
While every effort has been made to ensure the 
information in this document is accurate, NORBIT 
does not accept liability for errors or omissions. 
 

About This Manual 
This manual provides installation, configuration, 
integration, operation, and maintenance guidance 
for NORBIT WINGHEAD X, WBMS X, and 
WINGHEAD multibeam sonar systems. 

 
It applies to both integrated and non-integrated 
configurations, including single and dual head 
setups. The manual covers mechanical 
installation, electrical interfacing, software 
configuration, data acquisition, troubleshooting, 
and system maintenance. 
 

Document Revision 
Published: February 18, 2026 
Document Number: TN-240293 
Revision: 7 
 

Software Release 
GUI Version: 14.2.9 
Firmware Version: 5.7.34 
 

Reference Documentation 
The supporting documents listed below can be 
found on the USB memory stick delivered with the 
system. They can also be requested from 
NORBIT Support. 

TN-210082 - WINGHEAD Interface Description 
TN-190018 - Tilted Sonar Head Offsets 
TN-190041 - ROV/ASV/USV Integration 

  
Contact Information 
NORBIT Subsea AS 
Stiklestadveien 1 
7041 Trondheim 
Norway 
 
Phone: +47 739 82 569 
Support: https://norbit.com/subsea/support/ 
Email: subsea_support@norbit.com 
Web: https://norbit.com/subsea/ 
 

Covered Models 
This manual applies to the following systems: 

WINGHEAD X, WBMS X 
WINGHEAD B41, B43, B44 Deep Sea 
WINGHEAD i77h, i79h 
WINGHEAD B51S,  B51S LR 
WINGHEAD i80S, i80S Apogee, i80S LR 

 

https://norbit.com/subsea/support/
mailto:subsea_support@norbit.com
https://norbit.com/subsea/
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Glossary of Terms, Abbreviations & Acronyms 
 
AP+     Latest Generation Applanix GNSS/INS Subsystem 
ASV     Autonomous Surface Vehicle 
AUV     Autonomous Underwater Vehicle 
Aux     Auxiliary 
Bandwidth   Range of frequency sweep 
BNC     Bayonet Neill-Concelman (connector) 
BSO     Backscattering Strength Output 
C/A     Coarse Acquisition 
CMR     Compact Measurement Record (a GNSS correction format from Trimble) 
CoR     Centre of Rotation (or Centre of Gravity) 
CW     Continuous Wave (single frequency) 
EA     Equal Angle beam distribution 
ED     Equal Distance beam distribution 
FM     Frequency Modulation (swept frequency) 
FPGA     Field-Programmable Gate Array 
DGNSS    Differential Global Navigation Satellite System 
GND     Ground 
GNSS     Global Navigation Satellite System 
GPS     US Global Positioning Satellites (often describes all GNSS) 
GUI     Graphical User Interface 
IMU      Inertial Measurement Unit 
INS     Inertial Navigation System 
iSIU     Integrated SIU 
LED     Light Emitting Diode 
N/C     No Connection 
NMEA    National Marine Electronics Association 
NTP     Network Time Protocol 
NTRIP    Networked Transport of RTCM via Internet Protocol 
PPK     Post Processed Kinematic 
PPS     Pulse Per Second 
ROV     Remotely Operated Vehicle 
RTCM    Radio Technical Commission for Maritime Services 
RTK     Real Time Kinematic 
Rx      Receive 
SBAS     Satellite Based Augmentation System 
SBG     SBG Systems GNSS/INS Subsystem 
SIU     Sonar Interface Unit 
SNR     Signal to Noise Ratio 
SONAR    Sound Navigation and Ranging 
STX     Steerable Transmission 
SV     Space Vehicle (GNSS/INS) or Sound Velocity 
SVP     Sound Velocity Probe 
SVT     Sound Velocity and Temperature 
TTL     Transistor-Transistor Logic 
Tx      Transmit 
USV     Unmanned Surface Vehicle 
VDC    Volts – Direct Current  



 

 
 
 

 

TN-240293  1 

 

  INTRODUCTION     

 Introduction 
NORBIT sonars are compact, high resolution, wide-swath multibeam systems with receiver beam 
widths down to 0.5° at 400 kHz (WINGHEAD X) and 0.9° (WBMS X). With a dry weight less than 4.5kg 
and low power consumption, the systems can be deployed on a wide range of survey platforms. 
 
NORBIT’s sonar technology is unique to the industry as the first platform designed as a cylindrical 
array wideband system with frequency modulated (FM) transmission, forming 256, 512 or 1024 
beams over a user-selectable 5° to 210° swath, providing accurate and repeatable bottom 
detections. All bathymetry processing and time-stamping occur inside the sonar head. A single 
cable powers and connects the sonar to a small Sonar Interface Unit (SIU), which connects to a data 
acquisition PC via a single Ethernet cable. 

 
Through tightly integrated GNSS/INS options, integrated surface-sound-speed measurement, and a 
single-cable architecture, NORBIT systems minimise installation effort and reduce overall system 
complexity. 
 

 

1.1 Product Overview 
NORBIT sonars are available as standalone sonar systems or with tightly integrated GNSS/INS 
solutions. The latest X series shares a unified platform, offering adaptable systems with a standard 
core configuration and optional licensed features that can be enabled as needed to expand 
capability. 
 
 

   

   
Built on a modular platform, the X sonars offer ultimate flexibility 

and can be customised for any operational environment. 

Ultra High-Resolution Curved Array 
Bathymetry Systems 

0.5 x 0.9⁰ at 400kHz 
0.3 x 0.5⁰ at 700kHz 

1.0 x 1.8⁰ at 200kHz (LR) 

0.9 x 0.9⁰ at 400kHz 
0.5 x 0.5⁰ at 700kHz 

0.5 x 0.9⁰ at 400kHz 
0.3 x 0.5⁰ at 700kHz 

1.0 x 1.8⁰ at 200kHz (LR) 

Multibeam 

LiDAR (Optional) Ethernet Interface 

Primary GNSS Secondary GNSS 

NORBIT GUI 
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  INTRODUCTION     

The table below provides an overview of the products and their key specifications. Note that some 
features are license-controlled (see Appendix B1). 
 

Product 
Nominal 

Frequency 
Beam Width 

Across x Along 
INS Options Depth Rating Dual Swath Stabilisation  

The X Series 

WINGHEAD X 400kHz 0.5 x 0.9⁰ ◆  ◇ 100m ✓ Roll, Pitch, Yaw 

WINGHEAD X LR 
200kHz 
400kHz 

1.0 x 1.8⁰ 
0.5 x 0.9⁰ ◆  ◇ 100m ✓ Roll, Pitch, Yaw 

WBMS X 400kHz 0.9 x 0.9⁰ ◆  ▲  △  ● 100m ✓ Roll, Pitch, Yaw 

WINGHEAD Series 

WINGHEAD B41 400kHz 0.5 x 0.9⁰ - 100m ✗ Roll 

WINGHEAD B43 400kHz 0.5 x 0.9⁰ - 1500m ✗ Roll 

WINGHEAD B44 Deep Sea 400kHz 0.5 x 0.9⁰ - 4500m ✗ Roll 

WINGHEAD i77h/i79h 400kHz 0.5 x 0.9⁰ ◆  ◇ 100m ✗ Roll 

WINGHEAD B51S 400kHz 0.5 x 0.9⁰ - 100m ✓ Roll, Pitch, Yaw 

WINGHEAD B51S LR 
200kHz 
400kHz 

1.0 x 1.8⁰ 
0.5 x 0.9⁰ 

- 100m ✓ Roll, Pitch, Yaw 

WINGHEAD i80S 400kHz 0.5 x 0.9⁰ ◆  ◇ 50m ✓ Roll, Pitch, Yaw 

WINGHEAD i80S LR 
200kHz 
400kHz 

1.0 x 1.8⁰ 
0.5 x 0.9⁰ ◆ 100m ✓ Roll, Pitch, Yaw 

       

◆ Applanix OceanMaster    ◇ SBG Apogee    ▲ Applanix WaveMaster    △ SBG Ekinox     ● Applanix SurfMaster 
 

1.2 Advantages of NORBIT Technology 

 Advantages of the Cylindrical Array 

• Unlike a flat array, bottom detections from a cylindrical array are much less susceptible to 
surface sound speed errors. 

• Due to proprietary progressive beamforming techniques supported only by cylindrical arrays, 
NORBIT sonars form narrower beams than flat arrays, resulting in superior bathymetry quality. 

• At all frequencies, NORBIT sonars provide increased swath coverage with a smaller beam 
footprint for a fixed aperture. 

• The cylindrical array of the NORBIT sonars can cover a full 210°. Flat array systems would lose 
data fidelity at much lower swath angles (±80°) and would necessitate mounting two or three 
sonars at angles to achieve higher swath coverage. 

• The cylindrical array's hydrodynamic profile enables faster transit, reduced vibration, and lighter 
mounting hardware. Sturdier mounts, like hull mounts, support transit speeds >20 knots. 

 Advantages of the Integrated INS 

Factory integration of critical sensors provides several benefits. Offsets between the sonar and 
inertial navigation system are fixed and predefined within the system setup. The user need only 
measure the offset to the bottom of the primary GNSS antenna. 
 
Cabling and software integration between the sonar, positioning, heading, attitude and sound speed 
probe is handled internally. The onboard surveyor need only connect the wet end to the topside via 
a single cable and then connect the primary and secondary GNSS cables (which are each labelled 
on both ends of the cable to remove installation uncertainty). 
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 Advantages of Steerable Transmission 

NORBIT sonars offer steerable transmission functionality, which brings several new license-
controlled features to the user (see Appendix B1). Dual Swath  enables higher sounding density, or 
increased survey speed, by transmitting multiple pings simultaneously, while pitch and yaw 
stabilisation provides uniform sounding density by actively steering the transmit beam to 
compensate for vessel motion. 
 
In addition, the STX scanning feature enables the transmit beam to be directed ±10° in a scanning 
pattern. This feature allows the system to ensonify areas that traditional modes cannot reach, most 
notably behind vertical structures such as pilings. STX scanning can also capture additional details 
on complex features, such as shipwrecks, during a single pass. It can be enabled at any time and 
works by defining a step size, where each step angle occurs with each ping.  The duration of a full 
scan depends on the current ping rate – for example, at 20Hz ping rate with a step size of 20, one 
complete scan takes 1 second. 
 

 
 

STX scanning supports additional applications such as obstacle avoidance, dredge monitoring, and 
cable lay operations. The sonar can be mounted in any orientation to change the scanning pattern. 
For example, rotating the sonar 90° in heading, combined with an upward tilt, allows the sonar to 
scan a ±10° sector ahead of the vessel. 
 
The special STX 360 configuration integrates the scanning sonar with a rotator to provide 360° real-
time coverage from a static platform. This provides rapid and efficient dredge monitoring compared 
to conventional methods, since no vessel sailing is required. 

1.3 System Specifications 
While continual improvements are being implemented, specifications may change. To obtain the 
most current specification sheets please visit https://www.norbit.com/subsea/ 

1.4 Export, Shipping Weight & Dimensions 
Each standard NORBIT system is shipped in a single, lightweight Pelican case that meets airline 
baggage guidelines. Refer to the NORBIT website for shipping weights and dimensions. 
 

• Airline Checked Luggage: Although the rugged freight case includes dense foam shock 
absorption, handle it with care and ensure it has a prominent airline "Fragile" label. 

• Airline Carry-On Baggage: The sonar case may be hand-carried onto many airplanes, but it is 
often required to remove the sonar from the case for x-ray security screening. 

Vertical Structure Mapping with STX Scanning Without STX Scanning 

Forward sweep ensonifies the area behind 
the piling before the vessel is adjacent to it. 

Aft sweep ensonifies the area behind 
the piling after the vessel has passed it. Acoustic shadow zones 

behind pilings in traditional 
bathymetry mode. 

https://www.norbit.com/subsea/
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 ITAR Restrictions 

All systems are free of Canadian and EU export controls. NORBIT recommends DHL as a preferred 
shipper when shipping internationally. All shipping documents from the USA should quote: 
 

• ECCN 7A994 classification number for all integrated systems (containing an integrated 
GNSS/INS) e.g. WINGHEAD i77h, iWBMS X, etc. 

• ECCN 6A991 classification number for all non-integrated systems (i.e. not containing an 
integrated GNSS/INS) e.g. WBMS X, WINGHEAD B41, etc. 

1.5 Technical Support 
NORBIT offers global technical support. Please refer to section 7 before contacting NORBIT Support. 
To raise a request, register an account at the NORBIT helpdesk, select “Technical Support” and 
complete the form including the following details: 
 

• Your name, organisation and system details (model, serial number and software versions). 

• A detailed problem description, with photos or screenshots where relevant. 

• Error messages, system logs (see section 4.8.6.4) and relevant INS logs where applicable (found 
at: C:\Users\<user>\Norbit\WBMS\) 

Data samples if relevant. Raw data recordings from the GUI should include water column data 
(ensure that WC Resolution is set under Backscatter Controls and displayed on the wedge.) 
 

If replying via email, include the unique ID (NSS-XXXXX) in the email subject. When emailing NORBIT 
Support directly, a ticket and account will automatically be generated for you. To access the ticket, 
select the “Forgot your password” link to reset your password. 

 
NORBIT Subsea AS 
Stiklestadveien 1 
7041 Trondheim 
Norway 

Support: https://norbit.com/subsea/support/ 
Email: subsea_support@norbit.com 
Phone (GMT): +47 739 82 569 (For urgent enquiries) 
Phone (US Time): +1 929 2667 248 
Phone (APAC): +65 6349 2251 

 

1.6 End-of-Life Management & Recycling Information 
Electronic products must not be disposed of in regular household waste. To ensure environmentally 
compliant end-of-life management, you can return the product to a certified waste facility for proper 
handling or return it to NORBIT for appropriate disposal. Contact NORBIT Support for detailed 
instructions or assistance with returning your product. 

 

https://norbit.com/subsea/support/
mailto:subsea_support@norbit.com
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  HARDWARE INSTALLATION     

 Hardware Installation 
Refer to Appendix C for the hardware dimension drawings. NORBIT can provide 3D models of the 
transducers, in the STEP file format, to support your installation plan. 

 

⚠ 
CAUTION: Though many cables and connectors appear similar across different 
models, they are not cross-compatible. For reliable operation and to maintain 
warranty coverage, use only the original cable parts supplied with your system. 

 

ⓘ 
NOTE: For subsea ROV/AUV and USV installations, please consult TN-190041 
for detailed technical guidance as well as critical safety notices. This document 
can be obtained from NORBIT Support. 

 

2.1 Power Requirements 
NORBIT sonars require clean, continuous power for reliable operation. Please refer to the 
requirements below for AC and DC power options and refer to the datasheets on the NORBIT website 
for power consumption values. 

 AC Power 

Most vessels use an inverter to provide continuous power. It is important that the inverter is a true 
sine wave inverter. A modified sine wave inverter may cause unexpected behaviour, even when 
using the included power brick (PN 23008). Use high-quality inverters to provide power. 
 
In general, inexpensive inverters produce a modified sine wave. “Dirty” power may cause data loss, 
system reboots, or electronic damage. To confirm whether the inverter is the source of the problem, 
the system can be powered directly from a 12-24 VDC battery. An oscilloscope can also be used to 
observe the quality of the AC supply. 

 DC Power 

Power may also be supplied directly from a deep-cycle battery using the included pigtail connected 
to the SIU power port (12-24 VDC input). Thick wires should be used, minimising connection points 
to avoid voltage drop. If operating from a 12 V supply, using 2 batteries in series is recommended 
to reduce the impact of voltage drop. Voltage spikes exceeding 29V may damage the system. 

2.2 Wet-End Overview 
 

⚠ 
CAUTION: When handling the unit, do NOT lift, carry, or support it strictly by the 
sound speed probe or the projector alone. These components are not designed 
to bear the weight of the system. Always support the unit by its main housing. 

 

⚠ 
CAUTION: Ensure the wet-end connection is fully sealed. Inspect the O-ring, 
replace if needed, and apply a thin coat of synthetic grease (e.g. Molykote 55) to 
the O-ring. Hand-tighten the connector until firmly seated. If the threads stick, use 
a VERY thin coat of grease on the threads, but NOT the connector pins. 
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  HARDWARE INSTALLATION     

 WINGHEAD X 

The WINGHEAD X is offered in various configurations to accommodate different frequency and INS 
requirements, while using the same underlying hardware platform. With 0.5⁰ receiver beam width 
resolution, it offers flexible configuration options and can be upgraded with software features such 
as pitch stabilisation, yaw stabilisation, and dual swath. It uses a field-swappable SV sensor, and 
integrated models contain an IMU housed inside the projector. 

 

 WBMS X 

The WBMS X is built on the same concept as the WINGHEAD X (see section 2.2.1), offering the same 
features and flexibility, but with a more compact receiver array, giving 0.9⁰ resolution. It uses a 
removable, field-swappable SV sensor, and integrated models contain an IMU housed inside the 
projector. 

 

 WINGHEAD 

Other WINGHEAD models are offered in various hardware configurations. Integrated models contain 
an IMU housed inside the projector, or inside the front enclosure depending on the model. Typically, 
the SV sensor is tightly integrated and cannot be removed. A detachable SV option is also available 
(see Appendix B3). 

 

 

Cylindrical Receiver Array 

Sound Speed Probe 

Connector 

Mounting Bracket 

Projector array 

Sound Speed Probe 

Mounting Bracket 

Projector array 

Cylindrical Receiver Array Connector 

Cylindrical Receiver Array 

Sound Speed Probe 

Connector 

Mounting Bracket 

Projector array 

Mounting 
Bracket 

Sonar 
Connector 

IMU Connector 

WINGHEAD i77h WINGHEAD i80S 

IMU 

Sound Speed Probe Projector array 
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  HARDWARE INSTALLATION     

2.3 Dry-End Overview 
All NORBIT systems include a compact topside Sonar Interface Unit (SIU) which distributes power, 
time information and data between the sonar wet-end and the survey acquisition system. This 
environmentally sealed fan-less topside is dust-proof and splash resistant. 
 
The SIU will shut down automatically at 70°C to prevent damage to electronics due to overheating. 
Refer to Appendix D7 for the connector pinouts. 
 
 

⚠ 
CAUTION: The COM (DB9) and PPS connections on the SIU are not rated for 
voltages higher than 5V. Exceeding this limit could damage the system. Check all 
potential connections for unexpected voltages. Ensure there is no significant 
potential difference between the inputs/outputs of other sensors. 

 

⚠ 
CAUTION: When operating in open environments, all connection ports on the SIU 
should be tightly sealed either with the NORBIT supplied cables or, if the port is 
unused, with the port covers provided with the system. 

 

 Integrated Sonar Interface Unit (iSIU) 

 

GNSS/INS Options: PN 29093: Applanix AP+  |  PN 29060: Applanix AP  |  PN 29088: SBG 

 
Notes: 

i. The INS LEDs at the top of the SIU vary by model. Refer to section 2.3.4. 
ii. Refer to Appendix D7 for the connector pinouts. 

Connector Description  

Sonar 18-pin interface to sonar and integrated IMU 

Ant 1 Primary GNSS antenna 

Ant 2 Secondary GNSS antenna 

COM (Serial) GNSS corrections input (RTK/DGNSS) and GNSS/INS NMEA output. The optional 
split-serial upgrade allows GNSS/INS ASCII/binary data output for up to 3 serial 
connections (see Appendix B2) 

PPS 1PPS output for external sensor (not typically used) 

Ethernet For communication between topside PC and sonar 
(SAMTEC Part No. RCE-01-G-05.00-D) 

Aux In/Out 10-pin interface for communication with auxiliary devices (iLiDAR) and Trigger In/Out. 
Refer to section 2.3.3 for more details. 

10-28 VDC Input DC voltage. Refer to section 2.1 for power requirements. 
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 Sonar Interface Unit (SIU) 

 

PN 29064 

 

 
Notes: 

i. This model can also be combined with PN 29093 / 29060 / 29088 for dual head configurations. Refer 
to section 2.8 for more details. 

ii. Refer to Appendix D7 for the connector pinouts. 
 

 Aux In/Out Port & Triggering 

The Aux port provides trigger in/out functionality and, on integrated models, can interface with the 
NORBIT iLiDAR for simultaneous multibeam and topographic data collection. For detailed pin 
descriptions, see Appendix D7. 
 
Pins 5 and 6 can be used to trigger to or from an external sensor, such as a sidescan sonar or DVL, 
to prevent interference. The trigger output operates as RS-422, while the trigger input is both TTL 5V 
and RS-422 compatible, except in models equipped with the 18-pin 318E sonar bulkhead connector, 
where the input is RS-422 only (see Appendix D6). The IRIG-B time output is TTL. 
 
The trigger uses RS-422 in half-duplex mode, allowing the same pair to receive or transmit 
synchronisation depending on the designation. For synchronisation with another NORBIT sonar, 
connect pins 5 and 6 pin-to-pin with the corresponding unit’s SIU Aux port. NORBIT cable PN 33249 
can be used to achieve this connection. 
 

 

 
 

Notes: 
iii. The output trigger is sent 3300µs before the centre of the following transmit pulse. 
iv. The default delay from the incoming trigger is 3300µs to the centre of the next transmit pulse. 
v. A trigger cable solution (PN 33403, standard length 1m) is available, which converts the RS-422 trigger 

output from the SIU to a 5V TTL output on a BNC cable. For more information, contact NORBIT Support. 

 

Connector Description  

Sonar 10-pin interface to sonar 

COM (Serial) NMEA ZDA timing input  

PPS 1PPS input for timing 

Ethernet For communication between topside PC and sonar 
(SAMTEC Part No. RCE-01-G-05.00-D) 

Aux In/Out Trigger In/Out. Refer to section 2.3.3 for more details. 

10-28 VDC Input DC voltage. Refer to section 2.1 for power requirements. 
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 LED Status Indicators 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2.4 Sensor Installation 
 

⚠ 
CAUTION: The cables are NOT wet-mateable. Only connect cables to the 
connectors when dry. Use compressed air to ensure that they are clean and dry, 
and DO NOT apply grease to the connector pins. 

 

 Sonar Orientation 

Mount the sonar with the projector pointing aft so that the receiver operates in the quietest, least 
turbulent water for optimal SNR. Align the sonar with the keel or centreline, keeping it parallel to the 
water surface, ideally within 0.5°. 
 
NORBIT sonars have been tested at a transit speed of 20 knots without damage. When not surveying, 
keep the sonar out of the water during transit to protect it from physical damage. 
 

 

Indicator SIU Part Numbers Pattern Description 

Sonar 29064, 29093, 29060, 29088 Green 
Off 

Sonar On 
Sonar Off 

PPS 29064, 29093, 29060, 29088 Blinking Orange (1Hz) 
Blinking Orange (5Hz) 
Steady Orange 
Off                                                 

Sync/Timing OK 
No Sync, NMEA Missing 
No Sync, PPS Missing 
No Sync, NMEA and PPS Missing 

Aux In/Out 29064, 29093, 29060, 29088 Off Not in use (always off) 

Power On/Off 29064, 29093, 29060, 29088 Steady Green 
Blinking Green (5Hz) 
Off 

Input Voltage OK 
Input Voltage <10v or >28V 
No Input Voltage 

ETH 29060, 29088 Blinking Green 
Off 

Valid INS Ethernet connection 
No INS Ethernet connection 

INS 29060, 29088 Blinking Green 
Off 

INS receiving RTK corrections 
No RTK corrections 

GNSS 29093 Blinking Green 
Off 

INS Power OK 
No INS Power 

SV 29093, 29060, 29088 Blinking Green 
Off 

INS detecting satellite vehicles 
No satellite vehicles detected 

Fwd 

Stbd 
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 Sonar Draft 

Vessel draft has a direct impact on multibeam range performance. A deeper draft places the sonar 
further below the surface, where the water column is more stable and less aerated, and ensures that 
the sonar is not subjected to reflections from the hull or water surface. 
 
Increased draft is always beneficial and should be considered an advantage when evaluating 
expected range. The sonar should always be clear of the lowest part of the hull. It is critical that the 
sound speed sensor has a clean, bubble-free path. 

 

 
 

 Acoustic Clearance Zones 

Keep the area around the sonar clear and unmasked to minimise acoustic reflections and blocking 
in both the across-track and along-track directions. 
 
To achieve 210° across-track coverage (e.g. for lock surveys), the receiver requires  210° clearance. 
While this is not always possible on pole mounts, the sonar should be level with the keel as a 
minimum for full coverage on both sides. For standard seabed surveys, 180° clearance is sufficient. 
The minimum clearances are shown below: 
 

 
 
To take advantage of the ability to measure above horizontal, the clearance angle should be 
extended up to above the required field of view. 
 
For subsea (ROV/AUV) or other complex mounts, achieving the minimum along-track clearance for 
the projector may not always be possible. Objects within the minimum angle can cause reflections 
or echoes, especially acoustically bright surfaces, therefore the widest possible along-track 
clearance should be sought. 

2m 

Forward 

Placing all sensors on a common pole 
mount brings greatest ease and flexibility.   

Generally, mount the sonar at least 0.7m 
below waterline, and always below the keel. 

Down 

180° 
15° 5° * 

* 30° for WINGHEAD X, WBMS X and WINGHEAD B51S/i80S models 



 

 
 
 

 

TN-240293  11 

 

  HARDWARE INSTALLATION     

 Sonar Protection 

If the vessel is operating in shallow waters, and there is danger of collision with objects, protection 
should be considered. The sonar could be protected by a larger fairing which extends slightly below 
the front of the sonar for additional protection. 
 
A bullbar or cage assembly could also be placed around the sonar. The height of the bar should not 
be lower than the edges of the receiver array to maintain the necessary acoustic clearance. The 
cage must be absolutely rigid with respect to the sonar and must not generate excessive drag. If 
vibration is induced, it can negatively impact the integrated INS performance. 
 
An alternative option is to add one or more knives protruding down in front of the sonar. However, 
knives can introduce turbulence which affects acoustic performance, so it should not have a large 
cross section, and the number of knives should be kept to a minimum, e.g. 1 or 2. 

 

 

 Sonar Mounting Instructions 

NORBIT sonars are supplied with one of several mounting bracket configurations, depending on the 
system type. While each bracket has a unique design, all brackets feature the same bolt hole pattern. 
For details on which bracket is supplied with each model, refer to Appendix C. 
 
Each system is supplied with 4 M10x20, M10x30 and M10x40 bolts to accommodate most 
installations. Use high quality stainless-steel bolts to prevent corrosion, especially in saltwater. For 
long term mounting, use Loctite 242 Blue (do NOT use anything stronger) to prevent loosening 
during long deployments. Mounting poles require a minimum internal diameter of 5.8cm for 
connector clearance. 

 Bracket Type A 

This bracket is delivered with WINGHEAD X and WBMS X models, and generally all newer 
WINGHEAD models. The Long Range (LR) variant is wider at the bottom to fit the wider projector. 
Use 4x M10 stainless steel bolts and spring washers, inserting the bolts through the top of the 
bracket into the threaded holes, ensuring they do NOT protrude into the projector. 

• Torque limit: Tighten the M10 bolts by hand using a calibrated torque wrench, NOT exceeding 
25 Nm. Avoid using power tools. 

• Thread preparation: NORBIT recommends applying anti-seize compound to all stainless-steel 
threads (e.g. Loctite 8009 or equivalent). 

 

Extended Fairing Example Cage Assembly Knives 

Bracket 

9
5

m
m

 M10 
Thread 

Ø
1

3
5

m
m

 

4 x 90° 
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Ensure that the cable is routed through the designated cutout in the mounting bracket closest to the 
sonar connector. This routing secures the cable in a stable position, preventing unnecessary 
movement during operation. 
 
The bracket includes a mounting tab for securing a cable clip that supports the sonar cable. Attach 
the clip to the tab using the supplied screw to keep the cable firmly in place. Both the cable clip and 
screw are included in the accessories box, along with a spare. 
 

 

 Bracket Type B 

This configuration includes 2 brackets attached to each side of the projector array, oriented 
vertically, by default, for pole mount installations. The hole pattern is identical to Bracket Type A. 
 
Secure the sonar with 4x M10 bolts, inserted from the top of the brackets into the lock nut inserts, 
securing the cable in the groove. The bolts should be 18-23mm longer than the mounting flange 
thickness. The brackets can also be oriented in the horizontal direction for hull mount installations 
(see section 2.4.7), except for WINGHEAD B44 models, using up to 6 bolts. 
 

 

 
 
 

 

Cable Clip Screw 
Mounting Tab 

Pole Flange 

1
8

-2
3

m
m

 

Cable Groove 

Bracket 

Pole Mount Configuration:   Hull Mount Configuration: 

Tighten M6 bolts to 5Nm torque 

4 x 90° 

 
Ø

1
3

5
m

m
 

Cable groove 

 
  Ø10.5mm 

 
1

3
6

m
m

 

154mm 
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 Bracket Type C 

This bracket is used for WINGHEAD B51S and i80S models containing sonar PN 24115. The hole 
pattern matches Bracket Types A and B, and two length variants are available: 

• Standalone models (e.g. WINGHEAD B51S): 130 x 130 mm 

• Integrated models (e.g. WINGHEAD i80S): 130 x 223 mm (extended at the front for IMU support) 
 

Secure the sonar using 4x M10 bolts inserted from the top of the bracket into the captive Nyloc nuts. 
The bolts should not protrude more than 5mm below the mount to ensure that they do not touch the 
material of the sonar body. For permanent installations, additional support must be added at the 
rear of the sonar to support the weight of the projector. 
 
The correct shank length should be the height of the bracket (20mm), plus the mounting flange 
height and washer thickness. If the bolt is longer than required, use extra washers to adjust the 
length. When the NORBIT PORTUS pole is used, use M10x40mm bolts (20mm + 20mm + 1-2mm). 

 
 
 

⚠ 
CAUTION: Secure the cables to prevent vibration and damage, using steel flatbar 
or rodding for routing, plus hosepipe (or similar) for sheathing. Use Jubilee clips 
or band-it to secure. If securing the cable directly with metal clips, add protection, 
such as rubber or hosepipe, between the clips to prevent cuts. 

 

 Cable Routing 

Take care when routing and handling sensor cables and refer to section 2.4.5 for specific guidance 
on each bracket configuration. In general, be sure to: 

• Minimise bends, and avoid kinks, twists, or stretching. 

• Avoid pinching the cables in windows, doors, and other equipment. 

• Secure the cables to prevent movement and reduce wear on the sheath. 

• Keep long cables away from power sources and avoid tight coiling to prevent electrical 
interference. 

 
For pole mount installations, it is best practice to route the sonar cable through the mounting pole 
to protect it from vibration, knocks or flotsam. 
 
When connecting the cables, ensure the connectors are clean, dry, and properly aligned. Protect any 
exposed cable sections using a chafing guard (e.g. a short section of hose pipe) where necessary. 
 

Bracket Height 
(20mm) 

Flange Height 

B
o

lt
 L

e
n

g
th

 

X X 

 
Ø

1
3

5
m

m
 

M10 Thread 

4 x 90° 
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 Hull Mounted Systems 

NORBIT sonars can also be permanently hull-mounted to a vessel for operations that do not require 
the system to be portable. 

 Mechanical Guidelines 

Although every vessel is different, as a general guideline, the sonar should be installed around one-
third of the vessel length from the bow, where water flow is more stable. The mounting arrangement 
must ensure the sonar has an unobstructed view of the seafloor while remaining protected within 
the vessel’s hull profile. It must be carefully designed to prevent bubble formation, ensuring clean 
water flow over the sound velocity sensor. 
 

 

⚠ 
CAUTION: On permanent hull-mount installations, it is essential to support the 
weight of the projector. This should be considered during the installation design 
phase. 

 
 

   
Hull mounted WINGHEAD sonar installation on a large ocean-going vessel 

 

   

Hull mounted WINGHEAD sonar installation on the DriX Unmanned Surface Vessel (USV) 

 
To enquire about NORBIT’s hull-mounted design and installation service, contact NORBIT Support. 

 Antifouling Considerations 

Antifouling protection is mandatory for permanent installations. Extended submersion exposes the 
sonar to biofouling, particularly in warm or saline water. Even thin layers of growth can: 

• Attenuate acoustic signals 

• Reduce detection range and data quality 

• Increase maintenance frequency and downtime 
 
NORBIT offers factory-applied antifouling solutions which are tested for acoustic compatibility with 
the sonar. The installation design should also minimise marine growth on nearby structures and 
metalwork, which can otherwise become sites of heavy fouling. 
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 GNSS Antenna Installation 

 Antenna Models 

As standard, integrated NORBIT systems are supplied with 2 Trimble 540AP GNSS antennas for 
Applanix systems, and 2 VeroStar VSP6037L antennas for SBG systems. Only supported antenna 
models should be used. 
 
The antennas are mounted by screwing onto 5/8” UNC threads. The recommended maximum cable 
length is 30m to avoid signal degradation. For longer cable runs, LMR-600-specification cables are 
recommended. 
 
       Supported Antennas for Applanix Systems            SBG Systems    

 
   

 
 

Trimble 540AP Trimble 382AP Trimble GA830 Trimble Zephyr 3 Rugged VeroStar VSP6037L 

     L1 Phase Centre Offset (measured up from bottom of antenna)           

58mm 66mm 88mm 58.9mm (bottom of antenna) 
84.3mm (bottom of bracket) 

48.82mm 

 

 Antenna Placement 

• Mount the Primary Antenna (Antenna 1) closest to the IMU to minimise offset errors. 

• Mount the Secondary Antenna (Antenna 2) a fixed distance 
from Antenna 1, with 2m separation recommended. 

• Both antennas must be free from vibration and rigid with 
respect to each other and the IMU. 

• Ensure that both antennas have an unobstructed sky view for 
continuous satellite tracking. 

• Install both antennas parallel to the water surface (±3cm). 

• While the antennas can be oriented in any horizontal 
direction, it is good practice to align them parallel or 
perpendicular to the vessel centreline. 

 
 

⚠ 
NOTE: While antenna separations greater than the recommended distance of 
2m can improve heading accuracy, it increases the risk of independent 
movement between the antennas which degrades the performance. 

 

 Avoiding Interference 

• The antennas should be mounted away from adjacent reflective surfaces such as masts, 
bulkheads, and other metal structures. 

• Keep the antennas clear of transmitting antennas of any frequency (e.g. VHF/UHF radios, radar, 
satellite or cellular communication equipment). 

2m 
2m 

2m 
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2.5 Detached IMU 
If the IMU must be installed separately from the sonar on the vessel, NORBIT offers the IMUd option 
(Appendix C7), supplied in a box-shaped housing with a 50m depth rating, which is compatible with 
all integrated models. A Custom IMU Ref. Point offset is required in the INS Setup Wizard (see 
section 4.6.1.2). 
 
Operating the system in a detached configuration typically requires a split cable if the IMUd is 
installed ≤5m from the sonar, or an additional SIU and cable when the separation is ≥5m. The full 
interfacing requirements are described in technical note TN-230138. 
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2.6 Time Synchronisation 
Only standalone NORBIT sonars require a PPS & NMEA $GPZDA hardware input, as integrated 
systems receive timing from the internal GNSS card. Refer to section 4.8.5 for details on configuring 
the timing method in the sonar Web UI. 
 
The system supports baud rates from 4800 to 115200 and can maintain sync with other NMEA 
messages output on the same port as the ZDA+PPS. The input baud rate is auto-detected on startup, 
therefore if the baud rate is changed, the SIU must be rebooted. Ensure that the baud rate is 
sufficient for all strings. 

 

⚠ 
CAUTION: The integrated versions of the SIU output PPS pulses on the PPS 
port. It is NOT an input. Attaching an active PPS cable to this port will damage 
the internal electronics and void the warranty. 

 
The PPS can be input in two ways: 

• To the BNC “PPS” connector on the non-integrated SIU 

• To the Serial “COM” DB9 connector on the non-integrated SIU (pin 9 for pulse & pin 5 for ground) 
 
The PPS signal can be either active low or active high. The SIU synchronises to the falling edge of 
an active low signal, or the rising edge of an active high signal. The voltage on the PPS should not 
exceed 5V. 
 
The SIU should receive a PPS TTL input at 3.3V (5V tolerant). The SIU can autodetect a negative or 
positive PPS input and has ±15kV ESD protection, ±60V fault protection. Integrated GNSS/INS 
NORBIT systems can output a (positive or negative configurable) PPS TTL signal at 5V. However, it 
is NOT fault protected and is rated for a maximum absolute voltage of 6V. 

 

 
 
The included DB9 timing cable should be used to interface a GNSS for timing. It splits the signal so 
that both the survey computer and SIU can be connected to the same GNSS port. 
 

  

Timing Cable Pinouts 

A B C Description 

1 1 1 N/C 

2 2 2 Transmit Data (from GNSS) 

3 3  Receive Data (to GNSS) 

4 - - N/C 

5 5 5 Ground 

6 - - N/C 

7 - - N/C 

8 - - N/C 

9 - 9 PPS (from GNSS) 

Active Low PPS 
 
 
 
 
 
 

Active High PPS 

+5V 
 
 
 
 

0V 
 
 
 
 
 
 

+5V 
 
 
 

0V 
 

Sync Time 

Up to 200ms 

PC SIU 
Serial       PPS 

Port 1         Port 2 Port 1            PPS 

PC SIU 
Serial        PPS 

ZDA 
PPS 

GGA 
GSV… 

SIU Timing 
Cable 

SIU Timing 
Cable 

ZDA 
GGA 
PPS 

ZDA 
GGA 

Coax 
Cable 

GNSS GNSS 

         Method 1                           Method 2 

A A 

B 
B C C 
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2.7 Single Head System Interfacing Diagrams 

 Integrated Systems 

For systems that include integrated GNSS/INS components, the requirements for sonar time 
synchronisation are handled internally, eliminating the need for any external hardware timing inputs. 
 

 

 Non-Integrated Systems 

Consult the manuals of your chosen ancillary sensors for details on configuring the required outputs 
for the sonar. While the precise configuration may differ based on the sensors employed, the 
essential requirements on the sonar side remain consistent: 

• The sonar requires NMEA $GPZDA (at 1Hz update rate) and 1PPS inputs from a GNSS receiver 
for sonar time synchronisation (see section 2.6). 

• For active roll stabilisation (and pitch and yaw, on supported models), motion data should be 
interfaced to the PC or laptop which runs the NORBIT GUI. The accepted formats are TSS1 and 
EM3000, and high update rates of at least 50Hz are recommended (see section 4.6.8). 

• If the PC or laptop does not have multiple network ports, a network switch should be used. 
Otherwise, the sonar Ethernet cable can be connected directly to the PC. 

 

 

Multibeam 

LiDAR (Optional) Primary GNSS Secondary GNSS 

NORBIT GUI 

Power Supply 
(24VDC) — Ethernet 

— NORBIT Cable  

SIU 

Multibeam 

SIU 

Sonar data to NORBIT GUI 

Navigation data to acquisition software 

UDP TSS1 or EM3000 (50Hz) to NORBIT GUI 

Trigger In/Out (RS-422) 

NORBIT GUI 

Power Supply 
(24VDC) 

SBES, SBP, etc. 

Position, Attitude and 
Heading Systems 

GNSS 
Receiver 

— Ethernet 
— DB9 Serial ($GPZDA In at 1 Hz) 
— BNC (1PPS In) 
— NORBIT Cable  
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2.8 Dual Head System Interfacing Diagrams 
Compatible cables are required based on both the topside connector (18-pin or 10-pin) and wet-end 
connector type (see Appendix D). The trigger cable (PN 33249) is required for synchronisation 
purposes. For more details on dual head operation, refer to Appendix A2. 

 Integrated Systems 

 
Although not standard, it is also possible to run integrated systems using 2 iSIU with a similar 
interfacing scheme. The secondary system must have at least 1 GNSS antenna connected for timing 
purposes, and the IP address of the secondary INS must be changed to avoid INS network conflicts. 

 Non-Integrated Systems 

 

Multibeam (Primary) 

Primary GNSS Secondary GNSS 

NORBIT GUI 

Network 
Switch 

Multibeam (Secondary) 

Power Supply 
(24VDC) 

General Connections: 
— Ethernet   — NORBIT Cable 

Primary to Secondary Connections: 
— DB9 Serial ($GPZDA Out, 1 Hz) 
— BNC (1PPS Out) 
— Trigger (PN 33249) 
 

SIU 

iSIU 

Multibeam (Primary) 

NORBIT GUI 

Network 
Switch 

Multibeam (Secondary) 

Power Supply 
(24VDC) 

GNSS 
Receiver 

SIU 

SIU 

General Connections: 
— Ethernet   — NORBIT Cable 

Primary to Secondary Connections: 
— DB9 Serial ($GPZDA Out, 1 Hz) 
— BNC (1PPS Out) 
— Trigger (PN 33249) 
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 Reference Points 

3.1 Sonar Reference Point 
The Sonar Reference Point is where all sonar data (and INS data, for integrated systems) is valid 
upon output. The relevant offsets are shown in Appendix C, referenced from the Top Centre of 
Bracket, as well as the bottom edge of the receiver and back edge of the projector, for convenience, 
when the standard mounting bracket is not used. 

 
For integrated systems, all sensors in the data acquisition and processing software must have the 
same offset applied to the sonar reference point. It is defined as follows: 
 
 

 
 

3.2 IMU Reference Point 
For systems with integrated GNSS/INS subsystems, the relevant sonar and IMU offsets are detected 
automatically in the INS Setup Wizard. The output  is automatically corrected to the Sonar Reference 
Point. Therefore, knowledge of the IMU Reference Point is generally not required. For reference only, 
the IMU offsets and mounting angles are summarised in Appendix F. 

 
When the sonar and IMU are rotated, the offsets and angles must be adjusted accordingly. Consult 
the technical note TN-190018 for details. Contact NORBIT Support if you require this document. 

3.3 Overview of Reference Points 
A visual overview of the reference points is provided below. Note that the Top Centre of Bracket is 
merely a convenient control point (“Measure Point”) from which to measure the primary GNSS 
antenna for integrated systems, however no data output is valid at this location. The Top Centre of 
Bracket is defined as the centre of the mounting holes on the sonar bracket flange. 
 
For dual head setups, it is more convenient, and practical, to define the Measure Point as the Top 
Centre of Dual Head Bracket. 
 

 

Axis Location 

Fore-Aft At the centre of the projector array. 

Port-Starboard At the centre of the cylindrical receiver array. 

Up-Down A vertical offset referenced from the bottom edge of the cylindrical receiver array. 

Bottom of Receiver 

IMU Ref. Point Sonar Ref. Point Top Center Bracket 

Example illustration showing the reference points of a typical integrated NORBIT sonar. 
Refer to Appendix C and Appendix F for the relevant offsets for each model. 

Side View Front View 
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 System Operation 
The system is setup and controlled using the NORBIT Graphical User Interface. The GUI can also be 
controlled in headless/passive mode, as described in section 4.5. 

Multiple PCs can monitor the GUI, but only one can control the sonar. When using a network switch, 
each PC must have a unique IP address in the same range (see section 4.2). The data acquisition 
software must connect to the local IP address of the PC running the GUI. 

 

⚠ 
CAUTION: The integrated INS will not communicate correctly with the GUI if 
Windows Firewall blocks the required ports. Disable Windows Firewall or add a 
port exception as described in section 7.2. 

 

4.1 System Requirements 
Since all processing occurs inside the sonar head, the GUI can run on the same PC as the data 
acquisition software. Refer to your manual of your chosen software for recommended requirements. 
 
The GUI itself has minimal requirements. NORBIT recommends PC or laptop with Windows 11, 
2GHz+ processor, and ≥8GB of memory. Integrated motherboard graphics are sufficient for the GUI, 
but dedicated graphics are recommended for 3D data acquisition software displays. The 
recommended display resolution is 1400x900 or higher. 

4.2 Network Configuration  
NORBIT sonars connect to the acquisition computer via a standard Ethernet interface. The PC 
network adapter must be configured on the same static IP range. 

 

⚠ 
CAUTION: Changing the IP address of the integrated INS from the factory 
configuration (192.168.53.100 for Applanix, or 192.168.53.103 for SBG) will 
disable INS functionality within the GUI. 

 
 

To configure the IP address in Windows 11: 
1. Go to Settings > Network & Internet > Advanced 

Network Settings, then expand the relevant adapter. 
2. Select Edit next to More Adapter Options. 
3. Open the Internet Protocol Version 4 (TCP/IPv4) 

properties. 
 
The recommended IP address is 192.168.53.150 / subnet 
mask 255.255.255.0. It is essential to avoid conflicts with: 

• Sonar: 192.168.53.XX (XX = last two digits of serial no.) 

• Applanix GNSS/INS: 192.168.53.100 

• SBG INS: 192.168.53.103 / SBG GNSS: 192.168.53.104 
 
The IP address of the sonar unit itself should only be 
changed if absolutely required (see section 7.4). 
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⚠ 
CAUTION: Do NOT connect multiple network cards to the same static IP range, 
as doing so may cause duplication of navigation data, resulting in sonar data 
artifacts. The subnet mask does not matter. 

 

ⓘ 
NOTE: Make sure that DHCP servers are not running on the same network as the 
sonar. This causes automatic IP address assignment during bootup. If this 
occurs, power off the SIU, assign a static IP address, and power cycle. 

 

4.3 Sonar Connection 
After starting the GUI, the Connection Dialog opens 
automatically. A green indicator shows an active sonar on the 
network, while red indicates offline status. Highlight the sonar 
and click Connect. After the first successful connection, all 
subsequent connections are automatic. 
 
To connect two sonars in dual head mode, set the left sonar 
as the Primary sonar, highlight both sonars, and click 
Connect. For more details, see Appendix A2. 

 
After connecting, the GUI automatically verifies firmware 
compatibility (see section 4.4). For a full description of the 
Connection Dialog, refer to section 4.8.6.1. 
 
 

⚠ 
CAUTION: Whenever firmware is updated or a new GUI is installed, users are 
strongly advised to select Set Sonar Factory Defaults on the Connection dialog 
afterwards. 

 

4.4 Firmware Update 

 Standard Procedure 

When a firmware mismatch is detected, click Perform Update 
and follow the instructions. It is unsafe to turn off power to 
the sonar once the upgrade process has started. 
 
When the upgrade is complete, power cycle the sonar and 
select Set Sonar Factory Defaults on the Connection dialog. 
 
For WINGHEAD B51S and i80S models, containing sonar part 
number 24115, firmware updates must be applied through 
the sonar Web UI as described in section 4.4.2. 
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 WINGHEAD B51S, i80S & i80S Apogee Models 

Step 1. With the sonar powered on, open a web browser, and go to: 
http://192.168.53.XX:8080 (where XX is the last 2 digits of 
the sonar serial number). 

Step 2. Go to the Maintenance tab and click Reboot in the “Reboot 
to firmware upgrade mode” box. 

Step 3. Click OK when prompted. 

Step 4. The update file is located inside the GUI installation folder, 
in the Firmware subfolder: C:\Program Files (x86)\Norbit 
AS\WBMS\Firmware\wh-fw.swu 

Step 5. Drag and drop the *.swu file into the Firmware Update box. 
The update will begin automatically. 

Step 6. Do NOT turn off the sonar during the update. Upon 
completion, power cycle the system and select Set Sonar 
Factory Defaults on the GUI Connection dialog. 

4.5 Operation Without the GUI 
Some setups, such as those on AUVs, may require operation without the active use of the NORBIT 
GUI. For this purpose, the system can be configured to operate in Passive or Headless modes. These 
modes are not intended to be used where several observers are required, as it substantially 
increases sonar bandwidth and may cause data loss. 
 
For details on how to configure the sonar in these modes, refer to the ROV/AUV/USV Integration 
Manual, TN-190041. Additionally, users have the option to interface with the sonar at a script level 
by sending direct commands (ref. TN-210082); however, this approach should only be used if 
passive and headless modes are not viable. 

4.6 INS Tools 
The NORBIT GUI contains integrated INS functionality for 
systems which contain integrated GNSS/INS subsystems, 
allowing the sonar and INS to be setup and controlled from the 
same user interface. For users with standalone systems, most 
settings under the INS Tools are intentionally disabled. 

 INS Setup Wizard 

 Factory Settings 

To restore the factory settings, open the INS Setup Wizard and select Factory. This only resets the 
INS configuration and does not impact the sonar configuration or GUI display preferences. 
 
 

⚠ 
CAUTION: Offsets are stored on the operator PC. If the PC is changed, the 
displayed Measure Point to Antenna Bottom offset is from the Sonar Reference 
Point to the antenna phase centre. This does not affect operation unless the 
configuration is re-saved. Review all inputs prior to each survey. 
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For Applanix AP+ models, the factory settings are restored using the Web UI: 
 
Step 1. Open the AP+ Web UI (http://192.168.53.100) 

Step 2. If the left menu is not visible (AP+ firmware ≥8.44), 
triple-click in the empty area at the top-left of the 

Web UI to unlock the advanced menu   

Step 3. Go to Receiver Configuration > Application Files 

Step 4. If the AP+ firmware was recently updated, obtain the 
relevant clone file from NORBIT Support and 
upload it by selecting Operation: Upload Clone File 

Step 5. Select Operation: Install Clone File and select the 
file (*.xml) from the drop-down menu. 

Step 6. Ensure that the following selections are made: 

☑ Set system to default before installing clone file 

☑ Install static IP address and hostname 

☒ Do not install INS configuration 

☑ Install Security configuration 

Missing/unsecure password override: 

(leave blank) 

 
Step 7. Click OK and wait for the clone file to install. 

Step 8. Navigate to Receiver Configuration > Reset 

Step 9. Next to Reboot Receiver, click OK 

Step 10. The factory reset procedure resets the IMU mounting angles to zero, which are invalid for 
most installations. To restore the correct angles, run the INS Setup Wizard in the GUI. 

 
 

⚠ 
CAUTION: Installing a clone file via the right-menu in AP+ firmware ≥8.44  
(instead of the advanced menu as described above) will prompt for credentials 
(username: applanix, password: password). Do NOT change any other AP+ Web 
UI settings as this may affect communication with the NORBIT GUI. 

 

 IMU Offset & Mounting Angles 

The first page of the setup wizard shows the sonar model in 
the System selection, along with the relevant offsets and 
mounting angles. The model is automatically detected, and 
for most users there is nothing to change here. 
 
Select Custom for installations where the IMU is physically 
separated from the sonar using the IMUd option (see 
section 2.4.8.1 and Appendix C7). Most models contain 
tightly integrated IMUs which cannot be removed. 
 

 

ⓘ 
NOTE: The IMU mounting angles and offsets must be adjusted when the sonar 
is tilted, which is typical for dual head installations. For further information, refer 
to the technical note TN-190018 and Appendix A2. 

http://192.168.53.100/
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 Antenna Offsets 

A. Choose the Antenna Model 

• Typically Trimble 540AP (Applanix models) or 
VeroStar VSP6037L (SBG models). 

• This ensures that the correct phase centre offset 
is applied (see section 2.4.8) 

B. Define the Measure Point 

• Choose a convenient point from which to 
measure the primary antenna offset. Top Centre 
of Bracket is recommended. 

• For dual head, a Custom point using the top 
centre of the dual head bracket is more practical. 

• Measure the distance from Measure Point to 
Antenna Bottom and enter the values, noting the 
sign convention (positive down). 

C. Set Heading Threshold 

• For Applanix models, set the Heading Threshold for the alignment (see section 4.6.2). 

• The Default Value is suitable in most cases. 

• If the vessel cannot manoeuvre aggressively, select Custom and increase it in 0.5⁰ steps. 

D. Heading Alignment Method 

• If the primary to secondary antenna offset is already known (i.e. measured using land survey 
techniques), enter it using the Custom option. This is strongly recommended for 
installations on large vessels. 

• If the antenna vector is unknown, select Heading Alignment Wizard and the alignment 
procedure will commence after completing the INS Setup Wizard (see section 4.6.2). 

E. Visual Check 

• Plan View and Profile View displays the antenna positions with respect to the Sonar 
Reference Point, which can be used for visual verification. 

 

ⓘ 
NOTE: The Measure Point to Antenna Bottom offset is corrected to the Sonar 
Reference Point upon transfer to the INS, therefore the displayed offset may 
differ from that reported in POSPac, POSView, Qinertia, etc. 

 Centre of Rotation Offset 

Enter the Centre of Rotation offset relative to the 
Measure Point to improve heave accuracy. It is an area 
rather than a precise point, which varies with fuel 
stowage and weight distribution, so an approximation is 
sufficient. It is generally 3/4 distance from bow to stern, 
centred on the keel, and near the waterline. 

 Integrated DGNSS 

Satellite-based GNSS correction services include free 
regional SBAS services, and paid subscription services 
such as  Marinestar or Trimble RTX (see sections 4.6.6 
and 4.6.7). 

A 

B 

C 

D 

E 
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 Inputs/Outputs & RTK Corrections 

A. Configure Real Time Kinematic (RTK) Input 

Option 1: Corrections via radio 
i. Ensure the vessel’s radio has a serial output, 

containing ONLY the correction message. 
ii. Connect the serial cable to the SIU COM port. 
iii. Select COM Port as the RTK/DGNSS Input type 

and set the baud rate to match the radio. 
iv. Select the correction format (e.g. CMR+, RTCM 

3.x), noting that some models auto-detect it. 

Option 2: Corrections via NTRIP (Internet Required) 
i. Select Ethernet as the RTK/DGNSS Input. 
ii. Enter the credentials in the NTRIP Client. 
iii. Click Fetch Sources. 
iv. Select the source and click Connect. 

Option 3: Corrections via external software 
i. Selecting INS Controlled allows the RTK input to 

be controlled by external software solutions. 
ii. The GUI does not adjust any input settings. 

B. Configure NMEA INS Output (Optional) 

i. Select COM Port as the NMEA INS Output. 
ii. Select the desired NMEA output messages. 
iii. When receiving radio corrections, disable this 

output or separate the data input/output lines to 
prevent the modem from receiving NMEA data. 

C. Configure NMEA GNSS Output (Optional) 

It is also possible to output raw NMEA GNSS data over Ethernet on supported models: 

i. Select Ethernet as the NMEA GNSS Output. 
ii. Select the desired NMEA output messages. 
iii. The raw GNSS data (NOT the inertial solution) is output at the specified reference point 

(ARP or APC) over TCP port 50100 and can be used for navigation quality control checks. 

Although not recommended due to its inherent limitations, some models support Aux. GNSS Input: 

i. Select COM Port as the Aux. GNSS Input. 
ii. Enter the offset to the antenna phase centre from the Sonar Reference Point. 
iii. The INS compares its own solution quality against the auxiliary solution and uses the best. 
iv. The input must include NMEA GGA, and optionally GSV, GSA and GST at 1Hz update rate. 

 

ⓘ 
NOTE: For RTCMv3 corrections, NORBIT recommends sending either MSM7 
messages (1077, 1087, 1097, 1107, 1117, 1127 & 1137) plus legacy messages 
1006 & 1033 from the base station, or MSM4 messages (1074, 1084, 1094 & 
1124) plus 1006 & 1033. Do NOT mix MSM4 and MSM7. 

 

ⓘ 
NOTE: For legacy Applanix models in Tightly Coupled modes, selecting the 
correction format None (not recommended) enables non-GPS constellations in 
Closely Coupled modes, however not all data feeds the Kalman Filter. 

A2 

B 

C 

A1 A2 A3 
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 Heading Alignment Wizard 

If the primary to secondary antenna offset was not applied in section 4.6.1.3, a heading alignment 
must be performed when the system is first installed, or each time one of the INS sensors (IMU or 
GNSS antennas) is moved. GNSS corrections are essential, and RTK is strongly recommended. 

 
 

ⓘ 
NOTE: The procedure varies depending on the integrated GNSS/INS model and 
the instructions are displayed on the alignment wizard. Note that, for AP+ models, 
T04 logging stops and restarts multiple times throughout the process. 

 
 
Step 1. For AP+ models, enter the approximate antenna 

separation, and for SBG models, enter a first 
guess within ±0.1m accuracy to aid the 
alignment. Press Start to begin the process. 
 
Ensure that the antennas have a clear view of 
the sky, away from tall structures that impede 
GNSS performance. The installation must be 
rigid and vibration-free, and the primary antenna 
offset must be accurately applied as described 
in the previous sections. 
 

Step 2. Follow the recommended manoeuvres during 
the pre-alignment. The Heading Error RMS 
drops from 55° and the alignment begins once it 
falls below the defined Target Error and 
stabilises. Continue the manoeuvres until this 
occurs. The alignment is iterative for AP+ 
models, and it is normal for the RMS to jump to 
40° between iterations. 
 

Step 3. Follow the instructions and continue the figure-
of-eight manoeuvres. The completion time 
depends on the size of the vessel and the speed 
at which the manoeuvres are performed, as well 
as positioning quality. If the alignment is slow or 
fails to complete, ensure that both antennas are 
securely mounted and free from vibration. 
 

Step 4. The computed results are unique to each 
installation. If the primary to secondary antenna 
offset was measured beforehand, the 
calculated results should be similar. Click 
Commit to save the results. NORBIT 
recommends performing a patch test after the 
heading alignment. 
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 Sky Plot 

The Sky Plot displays the currently tracked GNSS satellites for each constellation: 
 

 

 System Status 

The System Status dialog reports any fault conditions that may occur during operation. 

• Check this display if the Faults indicator on the GUI status bar appears red. 

• Some items may appear red intermittently during operation (see section 7.2). 

• The displayed items vary by INS model, so the display may differ from the example below. 

The Version information block at the bottom shows: 

• INS hardware, software, and firmware versions. 

• Marinestar and Trimble RTX subscription expiry dates (MM/DD/YYYY). 

• Trimble RTX is only supported on Applanix models, and for SBG models, the Marinestar details 
are reported on the Septentrio Web UI (see section 4.6.6). 

 

 

 Restart INS 

This Restart INS option resets the Kalman filter, prompting the IMU to restart its levelling routine. 
Note that the navigation output stops temporarily while this process is underway. It takes a short 
time for the system to reinitialise and resume the normal operation mode. 
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 Marinestar Activation 

Step 1. Obtain the OMNSN ID (Applanix models: INS Tools > System Status) or PPP User ID (SBG models: 
http://192.168.53.103 > Information > Firmware & GNSS > Internal GNSS > Show Details). 

    

Step 2. Request your subscription from Fugro, noting that Applanix AP+ models are compatible only with 
the G4+ service. In your request, provide the OMNSN ID or PPP User ID from the previous step. 

Step 3. Schedule a time with Fugro to activate the subscription, ensuring that the system is powered on and 
tracking satellites (see next step) when the activation code is transmitted over-the-air. 

Step 4. For Applanix models, enable Marinestar in the INS Setup Wizard (see 4.6.1.5). Usually, Auto mode 
is sufficient, however a specific mode and frequency can be set using Custom. For SBG models, 
activate the service on the Septentrio Web UI (http://192.168.53.104) under Fugro Marinestar > 
Settings > Satellite Beam Selection Mode. 

Step 5. Inform Fugro when the system is ready and wait for the activation code to be sent. The SNR must 
be >35dB-Hz. It may take 30-45 minutes after the code is sent for the subscription to activate. 

Step 6. On Applanix models, check INS Tools > System Status for an updated expiration date to confirm a 
valid subscription. On SBG models, the expiration is reported on the Septentrio Web UI. Hover over 
the INS Status LED in the NORBIT GUI to see Pri. Marinestar… (or similar) status reported. 

 Trimble RTX Activation 

Step 1. Trimble RTX is a paid-subscription service that is only available on Applanix models. Select INS 
Tools > System Status to obtain the  Primary GNSS Receiver serial number: 

 

Step 2. Schedule a time for activation, ensuring the system is powered on and tracking the appropriate 
satellite when the activation is transmitted over-the-air. 

Step 3. Enable Trimble RTX in the INS Setup Wizard, as described in section 4.6.1.5. A firmware update 
may be required if the option is not available (contact NORBIT Support and include a screenshot of 
the System Status to confirm eligibility). In most cases, Auto mode is sufficient, however a specific 
satellite, frequency, and bitrate can also be set using Custom. The SNR must be >35dB-Hz. 

Step 4. Inform Trimble when the system is ready and wait for the activation code to be sent. The activation 
will be transmitted over-the-air (OTA) every 10 minutes for up to 1 hour. 

Step 5. For high/low latitudes with insufficient geostationary elevation, the NTRIP option may be used. An 
Internet connection and a valid subscription are required. Use the NTRIP Client under INS Tools, 
with the server address www.trimblertx.net and port 2101. No username or password is needed. 

Step 6. Confirm that the subscription is valid by observing the System Status window. You should expect 
to see the status Tracking, as well as an updated expiration date. The INS status will report Trimble 
RTX when the mouse is hovered over the INS Status LED indicator. 

 

ⓘ 
NOTE: If OTA activation fails, the subscription code can be applied manually. On 
AP+ models, use the Web UI (http://192.168.53.100 on the Receiver Options 
page), and on legacy models use POSView (Tools > Send receiver option key). 
Power cycle the system after applying the Option Code. 

http://192.168.53.103/
http://192.168.53.104/
http://192.168.53.100/
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 External TSS1 or EM3000 Input for Roll/Pitch/Yaw Stabilisation 

For non-integrated sonars, the NORBIT GUI can receive motion 
data from an external motion sensor for roll stabilisation and, 
for supported models, pitch and yaw stabilisation. 

Accepted Formats: 

• TSS1 (Convention: Port Up+, Bow Up+) 

• EM3000 (Convention: Port Up+, Bow Up+, Clockwise+) 

Note: EM3000 Includes heading, required for yaw stabilisation. 

Interfacing Requirements: 

• The message string must be sent to the PC running the 
NORBIT GUI, via COM Port or UDP protocol. 

• The Use TSS1 or Use EM3000 checkbox must be enabled, 
along with the relevant communication parameters. 

• ≥50Hz update rates are recommended. The minimum 
baud rate for a 50Hz update rate is 19200. The baud rate 
must match the output from the motion sensor. 

4.7 Sonar Wedge Display 
The sonar wedge shows a single ping of data from a thin slice of the water column. Up to 1024 
overlapping beams are displayed, each producing a depth sounding. 

• The wedge is used to monitor data quality and swath coverage. 

• Current settings and statistics, such as frequency, sound speed, date, time, and ping number, 
are shown next to the wedge. 

• Software and firmware versions are displayed at the top right corner. 

• In dual head mode, two swaths are displayed, with the left sonar labelled primary and the right 
sonar labelled secondary (see Appendix A2). 
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Each bottom detection point is assigned a quality flag 
based on the signal brightness and proximity to 
adjacent detections. These points are flagged, but not 
deleted, and can be filtered during post-processing. 
 
When the Multidetect option is enabled (see section 
4.8.5), additional detections are flagged accordingly. 

 Status Indicators 

 LED Indicator Description 

S
o

n
a

r 

Bathy Bathymetry data streaming status (TCP/IP subscription) 

SS 
WC 
SN 

Sidescan (SS), water column (WC), and snippets (SN) data streaming status (TCP/IP 
subscription). The indicators turn red when the backscatter signal is saturated (see 
section 4.7.3) 

Roll / Pitch / Yaw Stab Active motion stabilisation status (see section 4.8.5) 

IN
S

 

Status Navigation solution mode (e.g. FIXED RTK) and corrector stream status 

Health INS initialisation/alignment status 

Faults INS diagnostics status (see section 4.6.4) 

Logging INS raw observables recording status. Recording starts automatically, and hovering 
displays the file path. For AP+ models, delayed heave cannot be extracted from the 
T04 logs and must be recorded in the data acquisition software (see section 5) 

Attitude 
Heading 
Position 

Position, attitude and heading solution (latitude, longitude, roll, pitch, and heading), 
plus associated accuracy metrics when hovered. 

Primary / Secondary Tracked satellites on the GNSS antennas (see section 4.6.3) 

NTRIP Client NTRIP Client status (see section 4.6.1.6) 

 

 INS Status Description 

R
T

K
  FIXED RTK Tightly coupled using raw observables + corrections (RTCM 18 & 19, CMR, CMR+) 

 Pri. Fixed RTK Closely coupled using primary GNSS position data in RTK mode. 

 FLOAT RTK Same as FIXED RTK but with reduced accuracy. 

P
P

P
  Trimble RTX Satellite-based corrections using Trimble’s Real-Time eXtended (RTX) technology. 

 Pri. Marinestar Satellite-based corrections using Fugro’s Marinestar service. 

D
G

N
S

S
  RTCM DGNSS Tightly coupled using raw observables + corrections (RTCM 1 or 9) 

 CODE DGNSS Tightly coupled using raw observables + corrections (RTCM 18 & 19, CMR, CMR+) 

 Pri. DGNSS Closely coupled using primary GNSS position data in DGNSS mode. 

A
u

x
il

ia
ry

  Aux. WL RTK Loosely coupled using auxiliary GNSS position data in Wide Lane RTK mode. 

 Aux. NL RTK Loosely coupled using auxiliary GNSS position data in Narrow Lane RTK mode. 

 Aux. DGNSS Loosely coupled using auxiliary GNSS position data in DGNSS mode. 

 Aux. Float RTK Loosely coupled using auxiliary GNSS position data in Float RTK mode. 

O
th

e
r  C/A Closely coupled using primary GNSS position data in C/A mode. 

 DR No GNSS input is available; navigation is using only the IMU data. 

 
 

ⓘ 
NOTE: T04 data, recorded with Applanix AP+ models, is logged in GPS time 
instead of UTC time. As a result, POSPac users MUST export the PPK 
navigation solution using the Custom Smoothed BET UTC format. 

Quality (Flag) Description 

Bad (0) Low SNR, Low Collinearity 

Flyer (1) High SNR, Low Collinearity 

Low SNR (2) Low SNR, High Collinearity 

Good (3) High SNR, High Collinearity 

Multidetect (4) Additional Detections 
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 Viewer Bar 

 

 
Displays a time trace for each beam when water column is active. Select the active beam using the 
slider bar at the bottom. Left-click and drag to zoom in, and right-click to reset. 

 
Hide/unhides the sonar settings menu. The user still has control of the gates, and therefore the sonar 
range, by clicking/dragging the gates interactively on the wedge. 

 
Opens the sonar user manual in PDF format. 

 
Opens a real-time 3D point cloud display in a web browser on port 41800 (e.g. http://127.0.0.1:41800) 

 
Starts sonar pinging. Pinging starts automatically when the GUI is connected to the sonar. 

 

Stops sonar pinging. Pinging should be stopped when the GUI is running with the sonar out of water 
to prevent the electronics from overheating.  

 

Activates raw data recording, which is described fully in section 4.9.1. Recorded data can be replayed 
at any time, even during live operation (see section 4.8.6.3). 

 

Opens an adjustable zoom pop-up window on the sonar wedge. The window can be dragged to any 
part of the wedge to magnify any segment of the swath. 

 
Side Scan Length controls the duration of the backscatter waterfall display (30s default), while 
Brightness (20 dB default) controls the visual intensity of imagery data, for display purposes only. 

 Backscatter Optimisation 

Tuning the display Brightness (on the lower GUI bar) and Gamma Correction (under Advanced > 
Options) is only for visual purposes and does not affect the raw data. In contrast, TVG settings 
directly influence the backscatter data output, as detailed in section 4.8.3. 

 
Step 1. From the factory sonar settings, do not adjust Brightness. Use the default value of 20dB. 
Step 2. Under Backscatter Controls, set the WC Resolution, and select the Backscatter Mode. 
Step 3. Enable Use calculated absorption. Set the correct Temperature and Salinity for the environment. 
Step 4. Adjust Static Gain until the backscatter image appears unsaturated. 
Step 5. Make minor adjustments to Spreading to maintain a display with equal intensity across the seafloor. 
Step 6. Adjust Brightness on the display control bar if desired (for visual purposes only). 
Step 7. Ensure the SS, SN and WC indicators remain green, as saturated imagery will not be salvageable. 

 
Saturation occurs when backscatter image details are permanently lost, and the raw data shows 
uniform intensity values. If an image appears too bright or saturated but adjusting the Brightness 
restores details, it means the observed saturation is only visual and is not present in the raw data. 

 
✓ Unsaturated  ✗ Saturated  
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4.8 Sonar Settings 

 Recommended Settings 

As a starting point, the following settings are recommended for shallow water bathymetric surveys: 
 

✓ Use Mixed gates and set the Upper Gate to at least 1m. 

✓ Enable Adaptive Ping Rate and set the Lower Gate beyond the expected maximum depth, e.g. 
at 20m depth, set the Lower Gate to 200m in Range/Mixed modes, or 100m in Depth mode. 

✓ With Adaptive Ping Rate enabled, setting the Lower Gate beyond the maximum depth ensures 
fast ping rates, regardless of the Lower Gate (range) setting. This makes the sonar effectively 
“hands-off” by removing the need for constant gate adjustments as the depth changes. 

✓ Enable Automatic Zoom to keep the active portion of the wedge visible on the display. 

✓ Enable Auto under Tx Pulse Settings. 

✓ Set the Swath angle to 120-140°. Monitor the quality of the outer beams and adjust accordingly. 

✓ Set Adaptive Gates to Normal and choose the desired Beam Distribution mode. 

✓ Ensure that the correct Temperature and Salinity for the current environment are set. 

✓ Enable Roll Stabilisation (along with Pitch and Yaw Stabilisation on supported models) to 
provide even sounding coverage in dynamic sea states. 

 View  

View settings control the size of the swath and range over which 
the sonar will search for bottom detections. The sonar range (i.e. 
how far the sonar listens for a return signal) is a function of the 
Lower Gate, Swath angle, and swath pointing Direction, and must 
be greater than the expected maximum depth. 
 
As well as controlling range, the gates also serve as a noise filter 
by forcing bottom detections between the upper and lower gates. 
 

Setting Description 

Gate Mode Gates set the range of the sonar, as well as forcing bottom detections between the Upper 
Gate and Lower Gate, acting as a noise filter. There are 3 options: 

• Range: The upper gate is radial, and the lower gate is the outer edge of the swath. 
Ideal for shallow water bank to bank surveys, or when changing the Direction to 
survey vertical structures up to waterline. 

• Depth: The upper and lower gates represent fixed depths, with the lower gate 
attached to the two corners of the wedge. Suitable for most environments. 

• Mixed (Recommended): A combination of the previous two modes, with the upper 
gate a fixed depth and the lower gate attached to the lower edge of the swath. Useful 
for surveys with rapid depth changes because the lower gate does not require as 
much attention from the operator. 

 
When Depth mode is active, changing the Direction, or operating with a physically tilted head, 
may drastically reduce the ping rate. To avoid this, select Range or Mixed mode. 

Range Gates Depth Gates Mixed Gates 
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Upper Gate Sets the upper limit for bottom detections. Adjust by typing a number and pressing Enter, by 
clicking the up/down arrow buttons, or by clicking/dragging the gate on the wedge 
interactively. A minimum of at least 1m is recommended to avoid false surface detections. 

Minimum Value: 0.2m 
Maximum Value: 599m  

Lower Gate Sets the maximum depth (or range) limit for bottom detections. It should be adjusted so that 
the seabed is above the two corners of the wedge. Adjust by typing a number and pressing 
Enter, by clicking the up/down arrow buttons, or by clicking/dragging the gate on the wedge 
interactively. 

Minimum Value: 0.3m 
Maximum Value: 600m 

Swath Sets the total angular swath coverage. For typical harbour surveys, this is normally set to 
120-150°. Reducing the angle compresses the beams into a smaller sector, increasing the 
overlap between adjacent beams. In dual head mode, this setting defines the total coverage 
for both sonars combined and automatically allocates the required coverage to each head. 

Minimum Value: 5° 
Maximum Value: 210° 

Wedge 
Overlap 

Defines the percentage overlap between the primary and secondary sonar wedges when 
configured in dual head mode. With 100% overlap, both wedges fully cover the same area of 
the seafloor, providing double sounding density when the two sonars are mounted with zero 
rotation. If the overlap is <100%, the system automatically adjusts the Direction for each 
sonar to achieve the requested overlap (the Direction setting is therefore greyed out). 

Direction Sets the direction of the swath pointing angle. Useful when surveying slopes, shoreline, or 
mapping vertical structures. 0° places the swath symmetrically around nadir. To maximise 
ping rate while using this feature, it is recommended that Range mode is activated. 

Automatic 
Zoom 

Makes the active portion of the wedge full screen (for display purposes only). This ensures 
that detections are clearly visible on the display, even when the range is very long. This is 
most effective when using Adaptive Ping Rate with a large lower depth or range gate. 

 

ⓘ 
NOTE: In Equidistant mode, the swath angle cannot be increased such that any 
part of the swath exceeds an 80° pointing angle, i.e. 10⁰ from horizontal (so, a 
160° swath with 0° rotation or a 120° swath pointed 20° is the maximum.) 

 

 Backscatter Controls  

Backscatter Controls change the data dynamics and apply gain 
to fit in the dynamic range of the output data format (s7k). The 
sonar hardware has a limited time varied gain (TVG) which 
operates up to around 30m. Thereafter, TVG yields a constant 
level. This may be a problem for some processing software 
when creating seamless mosaics. The GUI removes this native 
TVG and applies the user specified TVG defined by: 
 

TVG = Spreading*Log10 (R) + 2*Absorption*R/1000 + Gain 
 
This TVG curve is a standard continuous function to allow the signal to fit in the data format range 
and prevent signal saturation. This digital gain is applied to all imagery output (backscatter and 
water column) but has NO impact on bathymetry data. Refer to section 4.7.3 for tuning 
recommendations. 
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Setting Description 

Static Gain Sets a fixed gain value that is used together with Spreading and Absorption to form the TVG 
curve. A setting of -30dB is suitable in most cases. Adjust the setting if the sonar signal 
becomes saturated, in which case the SS/WC/SN LED indicators appear red (see section 
4.7.1). This setting is recalculated automatically when the Spreading or Absorption settings 
are adjusted. 

Spreading Sets the spreading component of the TVG calculation. Spreading loss is a geometrical 
phenomenon in which signal intensity is reduced with increasing range, as wave fronts are 
spread over a larger area. 

Absorption Sets the absorption component of the TVG calculation, accounting for transmission loss 
caused by conversion of acoustic energy into heat, which depends on the environment. 
 
When Use calculated absorption is enabled, Temperature and Salinity must be set, which, 
alongside the centre frequency and sonar-measured nadir depth, are used to determine the 
correct absorption. The sonar incorporates safeguards to prevent rapidly fluctuating depth 
values impacting the calculation. When Dual Swath or Yaw Stabilisation are enabled, the 
absorption value is computed individually for each centre frequency. 

Backscatter 
Mode 

Sets the backscatter mode to Side Scan, Snippets, Snippet/Scan or None. When backscatter 
data is requested from external data acquisition software (via TCP/IP subscription), the 
backscatter mode selection is automatically configured and greyed out. If side scan data is 
requested by the acquisition software when Snippet/Scan mode is selected, Snippets-
Sidescan is generated so that (unlike regular side scan) a correctly positioned side scan can 
be derived from snippets. 
 
For optimal backscatter results, ensure that Scanning is disabled under Tx Pulse Settings. If 
the goal is to classify bottom types, collection of Snippets will be most helpful. Otherwise, 
snippets should be deactivated to conserve disk space and computational resources. 

WC 
Resolution 

Sets the resolution of water column data and displays it on the wedge. Note that if the 
resolution is set to None, water column data will NOT be recorded to raw *.wbm/*.s7k files. 
It is advised to keep the resolution low when computational resources are scarce. 
 

 Tx Pulse Settings      

Tx Pulse Settings control the characteristics of the acoustic 
transmission, which impacts data quality, resolution, ping rate, 
and range performance. For most survey applications, the default 
settings are suitable. 
 
When the STX scanning feature is licensed on supported models, 
this menu displays additional options to control the scanning 
mode. Refer to section 1.2.3 for more information. 

Setting Description 

Frequency Sets the centre frequency of the transmit pulse. Higher frequencies provide better resolution 
for a given depth, but also greater signal attenuation, especially in the presence of sediments. 
For most applications, use a frequency close to the design frequency, e.g. 400kHz for standard 
systems. Selecting a predefined frequency from the dropdown is recommended. 
 
At higher frequencies (e.g. 550kHz or 700kHz), the acoustic beam characteristics change in 
ways that affect outer-beam performance, particularly in complex environments. It is advisable 
to reduce the swath angle when working significantly above the system’s design frequency. 
Additionally, higher frequencies are not advised for physically rotated installations. 
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Mode Sets the sweep time of the signal transmission, which impacts range performance and ping 
rate. Shorter pulses allow faster ping rates in shallow water. The available selections are: 

• FM Long Range (recommended for most applications) 

• FM Short Range (for surveys in shallow water) 

• FM Extended Range (for maximum range in deep waters) 

• CW (legacy option, not recommended) 

The selection can be adjusted to control the range performance, where FM Extended Range 
applies the longest sweep time to maximise range. Note that using shorter pulses (e.g. FM 
Short Range) increases the effective ping rate in shallow water. 
 
For CW mode (not recommended) sweep time controls the range resolution and increases 
range performance at the expense of bottom detection quality. In FM modes (recommended), 
sweep time has no impact on range resolution. 

Resolution Sets the acoustic range resolution by controlling the pulse bandwidth. For FM modes, 
resolution is calculated as c/(2*Bandwidth), where c is the speed of sound. When maximum 
resolution (0.9cm) is set, 80kHz bandwidth is applied. Therefore, with a centre frequency of 
400kHz, the transmission sweeps from 360-440kHz. 
 
Moving the slider to the right enhances range performance in deep water by reducing 
bandwidth, but it generally should not exceed 8cm (9kHz bandwidth) to ensure high data 
quality. In CW mode, the frequency transmission is constant. However, the system performs 
optimally in FM modes, yielding highest resolution regardless of depth. 
 
In dual head configurations, setting the centre Frequency automatically applies bandwidth 
above and below this value to prevent frequency overlap and crosstalk between sonars. A 
minimum range Resolution of approximately 1.1cm, with corresponding bandwidth, is used 
with 400kHz frequency in FM Short Range mode. When longer sweep times are used, the 
applied bandwidth is reduced accordingly to minimise range resolution. 

AUTO Adjusts Mode, Resolution, Frequency and Pulse Amplitude for best performance in nearly all 
survey conditions. For backscatter surveys, unless very high ping rates are desired in shallow 
water, disable Auto and use FM Long Range with 0.9cm Resolution to ensure full processing 
of the backscatter signal. The system will otherwise switch between short and long pulses, 
which some processing software is unable to compensate for. 

Ping Rate Sets the rate at which acoustic pulses are transmitted, which, together with vessel speed, 
impacts along-track sounding density. Certain factors such as depth and sweep time (Mode) 
will limit the maximum achievable ping rate. In deeper water, lower ping rates should be 
expected since the signal travel times are longer. 

• Adaptive (Recommended): The system searches for the greatest bottom detection 
range over a certain number of pings and revises the transmission timing to match this. 
This ensures that the system always pings at the maximum rate, regardless of where 
the Lower Gate (range) is set. Ideal for high resolution data over rapidly changing 
bottoms or surveys that do not allow for full-time, hands-on operators. 
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• Full Range: The ping rate is based on the total effective range as defined by the Swath 
angle, swath Direction and Lower Gate. The rate is a function of the two-way travel-time 
of the signal from the projector to the bottom and back again, plus a small duration for 
ping processing and capacitor charge. 

• Fixed: The ping rate will not exceed the fixed value, even when the range makes it 
theoretically possible to do so. The maximum rate is based on the range as determined 
by the Lower Gate. Useful for reducing data volumes when operating at very short 
ranges (e.g. low altitude ROV surveys), as the system will attempt to ping as fast as 
possible up to the user defined threshold or the sonar range. 

• External: Each ping is triggered externally and only happens if the sonar is ‘ready’ when 
the signal arrives, e.g. if the sonar cannot ping faster than 10Hz due to range limitations, 
but the external signal is 12Hz, every other event will be skipped resulting in a 6Hz ping 
rate per every other signal. The external signal polarity is configurable. The minimum 
delay from the transmit signal to the centre of the transmit pulse is 500µs (half the 
transmit pulse buffer plus additional). An adjustable trigger delay is possible with 
millisecond resolution. 

Scanning Directs the sonar to sweep an along-track angular sector defined by the Opening Angle. If 
disabled, the sonar is directed to ping in one direction only, effectively behaving as a 
conventional multibeam sonar. It is NOT advised to perform an entire survey with scanning 
enabled. Use scanning only when attempting to further develop areas of interest. 

Steps The number of steps corresponds to the number of slices, or pings, in each defined along-track 
sector. For most applications, use a step size equal to, or less than, 20. This is configurable 
only if Scanning is enabled and the Opening Angle is set to a non-zero value. If the number of 
Steps is 20, and the Opening Angle is 20°, and the sonar ping rate is 20Hz, it will take exactly 1 
second for the sonar to scan the 20° sector. 

Direction Defines the angular direction forming the centre of the along-track sector, e.g. for a Direction 
of 5° and Opening Angle of 10°, the STX sonar will scan across a sector from 0° to 10°. 

Opening 
Angle 

Defines the angular sector through which the transmit beam is steered. Steering is limited to 
±10°, and as the angular Direction increases by 1°, the maximum Opening Angle decreases by 
2°. If the Direction is 0°, the maximum Opening Angle is 20°. 

Display all 
Angles 

When enabled, all angles in the sector being scanned by the STX scanning mode are displayed. 
When disabled, the GUI will display only the angle defined in Display Angle. 

Display 
Angle 

The user may define a single angle within the sector to show on the display. If Display all Angles 
is enabled, this setting is greyed out. 

 
 

ⓘ 

NOTE: High quality sonar data requires excellent Signal to Noise Ratio (SNR) and 
suitable TX settings to maximise swath width. For most conditions (temperature 
and salinity dependent) use FM Long Range mode with 0.9cm resolution. In 
deeper waters, if the useable swath width narrows, gradually move the 
Resolution slider to the right. When in doubt, use Auto. 

 

ⓘ 

NOTE: To obtain optimal backscatter results for bottom classification surveys 
using Snippets, disable Auto and set Mode and Resolution manually. Changing 
these settings during a survey may degrade data quality as the processing 
software is unable to compensate for variable pulse characteristics. When faster 
ping rates are required, use FM Short Range. 
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 Advanced 

Advanced settings allow the user to further customise the sonar 
configuration. The presented options depend on the sonar model, 
as some features are hardware limited, while some features are 
license controlled (see Appendix B1). 
 
Pitch and yaw stabilisation are only available on NORBIT sonars 
with steerable transmission functionality. When Multidetect is 
enabled, additional options are shown to control the detection 
sensitivity and output settings. 
 
 

Setting Description 

Adaptive 
Gates 

Adaptive Gates automatically track and follow the shape of the seafloor and are used to 
improve detection quality, working in conjunction with the fixed upper/lower gates. Note that 
they are NOT visible on the display. 
 
In areas with steep gradients or rapidly changing seabed, select Wide or Off. If the gates are 
too wide (or off), false detections may occur due to noise, second returns or marine life. The 
following applications are well suited for the corresponding settings: 

• Dredging Surveys: Normal Adaptive Gates 

• Engineering Surveys: Normal or Wide Adaptive Gates 

• General Bathy Surveys >40m: Narrow Adaptive Gates 

• General Bathy Surveys <40m: Normal Adaptive Gates 

• Wreck or Complex Structure Surveys: Wide Adaptive Gates or Off 

 

In some sea states, the gates may need to be set wider to avoid clipping data during large roll 
events. It is advisable to use adaptive gates in nearly all environments. 

Sound 
Speed 

Controls how the surface sound speed is applied for beam steering computations. If Auto 
Sound Speed is enabled (recommended) the sonar uses values from the integrated SV 
sensor. An incorrect surface sound speed will irreparably compromise data quality. 
 
The input range is 1300m/s to 1700m/s, which reflects default hardware capabilities. For 
marine conditions requiring a larger range, other models of the sound speed probe are 
available. When Auto Sound Speed is disabled, the last value at the head is used. 

Auto Sound 
Speed 

When this option is enabled, the speed of sound is taken from the probe at the sonar head. 
This is recommended unless the probe is damaged or there are too many bubbles affecting 
data quality, e.g. when surveying in rapids or surf-zone. 
 
If the sonar is powered on and out of water, or excessive bubbles are present, the GUI displays 
a warning that the sonar is “Out of water” and the sonar will stop pinging after a short period 
of time to prevent damage due to overheating. If the sonar temperature exceeds 65°C it will 
shut down automatically as a safety precaution. 

Upper adaptive gate 

Lower adaptive gate 

Bottom detections are 
forced within the 
adaptive window. The 
size can be set to 
normal, narrow or wide. Bottom detections 
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Stabilisation Motion stabilisation is used to increase survey efficiency, and is unrelated to motion 
compensation for georeferencing purposes, which is handled separately. Note that some 
options are licence-controlled. 

• Roll: Allows for a wider swath width in more dynamic sea states. Roll stabilisation 
compensates up to ±10º of roll. 

• Pitch: Allows the transmit beam to be compensated for up to ±10º of vessel pitch 
motion, providing more even along-track sounding coverage. 

• Yaw: Provides evenly distributed along-track soundings, and prevents gaps in 
coverage, by compensating for changes in vessel heading (up to ±10º). To avoid 
gaps between sectors, there is a small overlap in the nadir region. 

 

Pulse 
Amplitude 

Sets the transmission power. In highly reflective areas (e.g. lock chambers) it may be 
necessary to slightly reduce the pulse amplitude to reduce acoustic reflections and noise. 
Otherwise, it is best to leave it set to 15. Note that this option is disabled when Auto 
Mode/Resolution is enabled (recommended). 

Beam 
Distribution 

Several options are available providing both Equiangular (EA) and Equidistant (ED) beam 
spacing. Do not switch modes while logging data, as there is a short 1 second lag when 
switching modes. Note that some options are licence-controlled. 

• 1024/512/256 EA: The angular swath coverage is divided equally by 1024, 512 or 
256 (the total number of beams) to determine the angular beam spacing. Use this 
mode to increase resolution around the nadir zone. 

• 1024/512/256 ED: The beams are distributed across the swath so that the 
footprints have the same distance between them. The angular spacing varies 
across the swath. Use to increase resolution at the outer swath edges. 

• Dual Swath 2048 EA/ED: Use this mode to increase along-track sounding density, 
or increase survey speed, by transmitting multiple pings simultaneously. It 
generates 2x1024 soundings per ping, offset by ±1°. The benefits are most evident 
in deeper waters; at very short ranges, the benefits are minimal. Note that the 
selectable frequency is restricted to specific optimised frequencies. 

 

Displayed 
Swath 

Controls which frequency is displayed on the sonar wedge when the Dual Swath beam 
distribution option is enabled. 

Sonar Tilt Specifies the tilting angle in special mounting configurations, such as dual head, when the 
sonar is mounted at an angle. It allows the user to normalise the display, otherwise a flat 
seafloor will appear to be sloping. In dual head mode, the Sonar Tilt automatically sets the 
secondary sonar to the opposite tilt of the primary. Note that additional considerations are 
required when the integrated IMU is tilted, which are detailed in technical note TN-190018. 

 ✗ Roll Stab  ✗ Pitch Stab  ✗ Yaw Stab  ✓ Full Stabilisation 

Simplified illustration: 

Equiangular 

. . . . . . . . . . . . . .   . . . ...... . . .   . . . . . . . . . . . . . . 
. . . . . . . . . . . . . 

 

Simplified illustration: 

Equidistant  Dual Swath Equidistant 
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Multidetect Record up to 3 detections per beam, with one additional detection above and below the 
primary bottom detection. The upper/lower gates control which part of the water column is 
considered for additional detections. 
 
Multidetect operates outside the Adaptive Gates, which also controls the proximity of the 
additional detections to the seabed: Narrow gates keep them closer, while Wide gates allow 
them to be further away. Multidetect should not be enabled for the entire duration of the 
survey, as it may increase false detections and require additional data cleaning. Use it only to 
further develop areas of interest. 

Multidetect 
Sensitivity 

Adjusting the slider increases or decreases the sensitivity of the multi-detection algorithm to 
qualify the water column as a potential extra detection. 

Multidetect 
in S7k 
Output 

Select whether to output an additional detection above (Upper) and/or below (Lower) the 
bottom detection in s7k files generated by the GUI. 

Options →  
Display 
Preferences 

Bottom Point Size: Changes the point size on the 
wedge. Adjustable from 1-10. 
Display Text Size: Changes the text size on the 
wedge area. Adjustable from 1-12. 

Roll Rotation: Viewing options to show the roll 
stabilised wedge. 

Water Column Data Image Quality: Sets the 
resolution of the water column display. This does 
not affect output resolution. To ensure system 
resources are kept to a minimum for low-grade 
field laptops, run with medium or low graphics 
selected. 

Units: Selects the display units in the GUI to be 
shown as either metric or imperial. 

Bathymetry Colours: Adjusts the colour palette of bottom detection quality flags. 

Colour Map: Offers different colour settings for visualising the swath intensity data. 

Gamma Correction: Changes the visual contrast of the wedge intensity data. Setting the 
gamma too low will mute the intensity in the wedge display to nearly all off (black). Setting 
gamma too high will fuse the darkest areas with the brightest areas. A value of 2 is often the 
best. 

Options → 
Triggering 

The timing scheme is controlled in the Web UI at 
http://192.168.53.XX:8080, where XX is the last 2 
digits of the sonar serial number. 
 
For most installations, 1PPS+ZDA should be 
selected, in which case the GNSS signal provides 
the time stamp and associated 1PPS signal to the 
sonar. 
 
For installations where the SIU topside is not providing timing (e.g., ROV installations), an 
NTP+PPS timing solution is recommended: 

• A 1PPS pulse should be delivered to the sonar head via a zero-latency input on the 
TIME signal pair. 

• The 1PPS is validated against NTP time from a server on the sonar subnet, which 
must align with the 1PPS event within 100ms; otherwise, it will be rejected. 

• When the time is rejected, an error will appear in the Web UI Diagnostics tab, with 
the sonar wedge time turning red. 

• Pulses with a time difference >10ms, due to noise on the 1PPS line, will be ignored, 
and missing consecutive 1PPS pulses will trigger an error, also turning the time red. 
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• If a 1PPS signal is unavailable, time can be set using the NTP Only option with 
reduced accuracy, which may be suitable for platforms with low dynamics. This 
option requires that the NTP server is at a low STRATUM (<2) value and not too far 
away in the network (public servers are usually not good enough).  

 
More advanced users can use an external signal to trigger the sonar. The External Trigger 
polarity can be set to Rising Edge or Falling Edge. 

 

⚠ 
CAUTION: Triggering via the BNC connector on the SIU is NOT 
possible. This is only for 1PPS Out (integrated models) or 1PPS In 
(non-integrated models). Inputting a voltage to the BNC of an 
integrated SIU can damage the internal electronics. 

 

Options → 
Paths 

Recording Area 

Sets the recording folder location for native 
NORBIT (*.wbm), INS (*.000 or *.T04), s7k 
(*.s7k) and XYZ (*.xyz) data files. 
 
Note that the GUI must be restarted when the 
recording path is changed. 
 

ⓘ 
NOTE: T04 data, recorded with Applanix AP+ models, is logged in 
GPS time instead of UTC time. As a result, POSPac users MUST 
export the PPK navigation solution using the Custom Smoothed BET 
UTC format. 

 
 

Save s7k in the same folder as WBM 
When this option is deselected, it is possible to define a separate logging folder for s7k files. 
Otherwise, s7k and WBM files will be recorded to the same folder. 
 
Save XYZ file 
Enabling this option generates a raw XYZ point cloud file, together with the WBM and s7k 
recordings, for easy loading into CloudCompare or similar tools for quick visualisation. 
 
Save GNSS/INS Raw Observables to local PC storage 
Enables INS Ethernet data logging (*.000 format, or *.T04 format for AP+ models) for post-
processing and/or delayed heave extraction. This option should always be enabled, even 
when not post-processing INS data, as it is also useful for troubleshooting purposes. 
 
Additionally, INS data is logged by default to the internal 4GB (or 10GB on select models) 
storage in the SIU. When the storage is full, the oldest recordings are automatically 
overwritten. Recordings can be retrieved using an FTP client (e.g. FileZilla). 

 

• Systems with Applanix (Legacy) GNSS/INS Subsystem: 

Host: 192.168.53.100 Username: guest Password: applanix 

Note that for later models, delivered after 2020, the password is PSWXXXXX, where 
XXXXX is the Applanix serial number found on the INS Tools > System Status dialog, 
for example PSW12345. 

• Systems with Applanix AP+ GNSS/INS Subsystem: 

Host: 192.168.53.100 Username: Not required Password: Not required 

• Systems with SBG GNSS/INS Subsystem: 

Host: 192.168.53.103 Username: Not required Password: Not required 
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 Connection 

NORBIT sonars use a native data format. To ensure compatibility 
with data acquisition and processing software packages, a proxy, 
which runs automatically, translates this data to the well-known 
s7k data format. 
 
If required, the connection can be reset, and the Port number can 
be changed to avoid conflicts with other sensors. 
 
In dual head configurations, the configured Port number applies only to the primary sonar, and the 
secondary port is one number greater. For example, if the Port is set to 17000, the secondary sonar 
will be port 17001. Qinsy users should avoid port 7001, as it is occupied by the Qinsy dongle. 
 
 

ⓘ 
NOTE: To receive sonar and INS data into PDS and NaviScan, the Force Push 
option must be enabled. This option forces the output of 7k records without a 
TCP/IP subscription. 

 

 Connection Dialog & Connection State 

Select Sonar Connection to open the Connection Dialog: 

• Selecting Set Sonar Factory Defaults resets the sonar configuration but does not reset the 
integrated INS. When this option is selected, raw GNSS/INS logging briefly terminates. 

• Connection State contains basic information about the current connection status. If any 
indicators are red, action is required by the user. The example presented below shows that the 
sonar is not loaded with the firmware expected by the GUI (see section 4.4). 

• To disconnect the sonar, select the sonar on the Known Sonars List, and select Disconnect. 
 

   
 
The Primary and Unlinked options relate to dual head operation: 

• The Primary selection determines which sonar is primary and secondary. This should be the 
sonar installed on the left (port) side. 

• By default, all setting changes apply to both systems, while the Unlinked option (not 
recommended) allows dual head sonars to be operated independently. 

• Refer to Appendix A2 for more details on dual head operation. 
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 Sonar Simulator 

The simulator is started via the Connection Dialog. The Start Simulator button is hidden by default 
and can be enabled by adding the following lines to this file: C:\Program Files (x86)\Norbit 
AS\WBMS\config\factory_wbmsgui.ini 
 

[Gui] 

show_simulator_button=true 

 
Click Start Simulator, highlight the bathy simulator on the sonar list, and click Connect, ignoring any 
firmware compatibility warnings. Simulated data can be used for testing and training purposes. It 
does not output sound velocity or navigation data and is therefore not time stamped. 

 Playback 

The Playback tab displays all detected recordings. To open a 
recording, double-click the file name. To browse to another folder, 
select Browse. Recordings are saved by default to: 
C:\Users\<user>\NORBIT\WBMS\ 

• Only bathymetry and water column data are shown. 

• The window can be resized by dragging the central divider. 

• Settings and Controls are found on the left, including the Sonar 
Orientation. 

• To export the current ping, or a series of pings, use Export Current Ping or Export. 

• Additional options (s7k export, video export, etc.) are available on the left menu. 

• The playback controls are displayed at the bottom: 
 

 

 Log, Info & Version 

   

• Log: Displays system hardware events. Clicking System Log at the bottom shows a log of 
commands sent to the sonar by the GUI, which are also stored in this folder on the GUI PC: 
C:\Users\<user>\AppData\Roaming\Norbit\Logs\ 

• Info: Displays serial numbers, part numbers and revision numbers. 

• Version: Displays the current NORBIT GUI version and sonar IP address. 

Go to beginning 

Step backward (1 ping) 

Play / Stop Step Forward (1 ping) Insert Tag/Comment 

Open Zoom Control 

Insert a Duration Tag 

Repeat Playback 
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 Reprocessing 

The Reprocessing tab allows users to regenerate the 
following data products from raw WBM recordings: 

• s7k Files – This option can be used to generate new 
s7k files (*.s7k) with adjusted TVG parameters for 
backscatter data when the real time acquisition 
settings were not ideal (see section 4.8.3). 

• Grid DB – This option allows a database grid to be 
exported for display in DCT or NORdredge. The 
Database type and Grid Size can be set. 

• XYZ Files – This option creates XYZ point cloud files 
(*.xyz), when this option was disabled in real time, for 
easy loading into CloudCompare or similar tools for 
quick visualisation of the data. 

 
Select the required export formats, choose the vertical datum (Heave or GPS Height), specify the 
source folder containing the WBM files, and click Start export to begin the batch reprocessing. Note 
that the vertical datum is only applicable for Grid DB and XYZ File outputs. 

 Presets 

Users can save preferred sonar configurations using Save Config 
and apply them using Load Config. Presets include all sonar settings 
(frequency, swath angle, etc.) and display preferences and can be 
transferred between computers. The presets are stored at: 
%appdata%\NORBIT\PredefinedSonarSettings\ 
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4.9 Data Formats, Recording & Output 

 Raw Data Recording 

Bathymetry data with the full INS solution (for integrated systems), including delayed heave data, 
can be recorded in the native NORBIT format with extension *.wbm. Additionally, s7k files are 
exported automatically. The s7k format has a publicly available data format definition (DFD). 

 Recording Directory & Naming 

• Default recording directory: C:\Users\<user>\NORBIT\WBMS\  

• Each session is saved in a folder named: YYYY-MM-DD-HH_MM_SS 

• s7k files are split automatically into 1GB segments with numerical suffixes, e.g. 
YYYYMMDD_HHMMSS_1.s7k, YYYYMMDD_HHMMSS_2.s7k, etc. 

• The logging directory can be customised (see section 4.8.5). 

 Recorded Data Types 

The recorded data types are determined by the Backscatter Controls settings: 

• Backscatter Mode determines the backscatter imagery type. This does not affect TCP/IP 
subscription outputs to the data acquisition software (see section 4.9.2). 

• WC Resolution determines whether compressed water column is recorded. 
 

Backscatter Mode WC Resolution Recorded Data Types (WBM) Recorded Data Types (s7k) 

None None 
✓ Bathymetry 

✗ Water Column 

✗ Side scan 

✗ Snippets 

✓ 7027 

✗ 7042 

✗ 7007 

✗ 7028 

None Highest-Lowest 
✓ Bathymetry 

✓ Water Column 

✗ Side scan 

✗ Snippets 

✓ 7027 

✓ 7042 

✗ 7007 

✗ 7028 

Side scan Highest-Lowest 
✓ Bathymetry 

✓ Water Column 

✓ Side scan 

✗ Snippets 

✓ 7027 

✓ 7042 

✓ 7007 

✗ 7028 

Snippets Highest-Lowest 
✓ Bathymetry 

✓ Water Column 

✗ Side scan 

✓ Snippets 

✓ 7027 

✓ 7042 

✗ 7007 

✓ 7028ii 

Snippets/scan Highest-Lowest 
✓ Bathymetry  

✓ Water Column 

✓ Side scan 

✓ Snippets 

✓ 7027 

✓ 7042 

✓ 7007 

✓ 7028ii 

Notes: 
i. For systems which support GNSS/INS integration in the GUI, the 7k navigation records (Position: 1003, 

Roll/Pitch/Heave: 1012, Heading: 1013, Navigation: 1015, and Attitude: 1016) are also recorded. For 

systems equipped with a NORBIT Rotator, record 1017 is also supported. 

ii. When the Backscattering Strength Output option is licensed, record 7058 is recorded in addition to 7028. 

See Appendix B4 for more details. 
iii. Acquisition software data subscriptions override selections made in the GUI. Therefore, if side scan data 

is requested by the acquisition software, side scan data is recorded in the raw data files. 
iv. Bathy intensity values at the bottom detection point are recorded automatically in the bathymetry data 

packets. It can be used to provide coarse backscatter, separately from side scan and snippets outputs. 
v. The position output for integrated systems uses the real time navigation datum. By default, this is 

WGS84, but changes if the RTK corrections use another datum (e.g. RTK with NAD83 outputs NAD83). 
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 Data Output via Network Subscription 

The adjacent table lists the current s7k records output 
by the Proxy Server in the NORBIT GUI, which are 
available for data streaming via the TCP/IP 
subscription model (record 7500 with ID 1051). All 

subscriptions can be ended with record 7500, ID 

1052. 

 
For systems which support GNSS/INS integration in 
the NORBIT GUI, the relevant s7k navigation records 
(1003, 1012, 1013, 1015 and 1016) are also available 

for subscription. 
 

Supported single request records (via record 7500 

with ID 1050): 7001 

 
Successful requests are replied with record 7501 

(ACK) while unsuccessful requests return record 7502 

(NACK). This is based on the DFD version 2.43. 

 Data Rates 

The estimated data rates for a single head system are given below. When water column (WC) data 
is recorded, it is assumed that Medium resolution is selected. 
 
Raw files are recorded in the native NORBIT data format (.wbm) and are simultaneously exported to 
the s7k format, as detailed in section 4.9.1. 

 

 Data Types Data Rate by Ping Rate (Mbps) 

Bathy INS SS SN WC 
50Hz 25Hz 10Hz 5Hz 

WBM s7k WBM s7k WBM s7k WBM s7k 

1
0

2
4

 B
e

a
m

s
 ✓ ✗ ✗ ✗ ✗ 19.27 16.78 10.17 8.52 4.25 3.41 2.48 1.70 

✓ ✓ ✗ ✗ ✗ 25.16 16.80 16.10 8.63 10.23 3.59 8.45 1.88 

✓ ✓ ✓ ✗ ✗ 26.20 17.85 18.33 10.78 11.18 4.45 9.05 2.36 

✓ ✓ ✗ ✓ ✗ 35.26 37.36 23.47 31.54 13.50 13.81 10.32 7.05 

✓ ✓ ✗ ✗ ✓ 27.53 25.65 18.92 20.17 13.05 14.20 11.27 12.45 

5
1

2
 B

e
a

m
s

 

✓ ✗ ✗ ✗ ✗ 19.73 8.54 10.17 4.31 4.30 1.72 2.48 0.86 

✓ ✓ ✗ ✗ ✗ 25.15 8.62 16.10 4.45 10.23 1.90 8.46 1.04 

✓ ✓ ✓ ✗ ✗ 26.25 9.56 18.37 6.61 11.18 2.77 9.04 1.52 

✓ ✓ ✗ ✓ ✗ 35.26 18.92 23.47 15.94 13.50 7.00 10.32 3.61 

✓ ✓ ✗ ✗ ✓ 27.53 12.41 18.92 10.21 13.05 7.23 11.27 6.33 

 
 
INS log files for integrated models, containing raw GNSS/INS observables, are recorded at a rate of 
2MB per minute for models which support the *.000 format. For AP+ models which use the *.T04 
format, file sizes are significantly smaller due to compression, with a typical rate of 0.8MB per 
minute.  

Record Description 

7000 Sonar settings 

7004 Beam Geometry 

7006 Bathymetry data (obsolete) 

7007 Side scan data 

7027 Bathymetry data (and intensity) 

7028 Snippets data 

7042 Compressed water column data 

7058 Snippet Backscattering Strength 
(See Appendix B4) 

1003 Position 

1012 Roll/Pitch/Heave 

1013 Heading 

1015 Navigation 

1016 Attitude 

1017 Pan/Tilt (Rotator) 

7500 7k remote control with ID 1051 

7501 7k remote control acknowledge  

7502 7k remote control not 
acknowledge 



 

 
 
 

 

TN-240293  47 

 

  DATA ACQUIS ITION     

 Data Acquisition 
Integrated NORBIT systems output sonar and navigation data at the Sonar Reference Point (see 
section 3). Each device in the acquisition software requires the same offset to this location, i.e. the 
offset measured from the reference point defined in the acquisition software (e.g. vessel centre of 
gravity) to the Sonar Reference Point. If the optional iLiDAR is installed, its output is valid at the 
iLiDAR reference point. 

 

ⓘ 
NOTE: NORBIT recommends consulting the respective manuals of your chosen 
data acquisition software, as this section only describes the basic setup steps 
required for the most common software packages. 

 

If the reference point in the acquisition software is the same as the Sonar Reference Point, only the 
draft offset is required for the simplest setup. HYPACK users are advised that all offsets should be 
referenced from the vessel centre of gravity, and the vertical offset should be the same for all drivers, 
measured from the waterline to the Sonar Reference Point. 

5.1 NORBIT Data Collection Tool (DCT) 
DCT is a web-based survey acquisition utility, developed by NORBIT, aimed to simplify standard 
bathymetry survey operations. A grid can be displayed on any computer or mobile device, allowing 
quick estimation of survey coverage and data quality in real-time. 
 
DCT reports horizontal coordinates in the real time navigation datum, together with depths when the 
GPS Height vertical datum option is selected. By default, the reported positions and depths are 
referenced to the WGS84 ellipsoid, however when GNSS corrections are interfaced, the datum may 
change. For example, when RTK corrections are used with NAD83, the DCT output is NAD83. DCT 
does not change the datum or apply transformations. Refer to the dedicated DCT manual for full 
operational guidance. 
 

Step 1. Download Tiles 
Background tiles can be optionally downloaded and saved at the office prior to commencing the 
survey. This is useful when an Internet connection is not available onboard. 
 

Step 2. Start DCT 
Start the application from the desktop shortcut 
icon using Google Chrome or Mozilla Firefox. 
DCT can be accessed from the same PC as the 
NORBIT GUI, or remotely from anywhere in the 
world providing the device is on the same 
network. 
 

Step 3. Data Recording 
Press the record button to start/stop data 
logging. This commands the NORBIT GUI to start logging s7k files, and a real time grid is displayed. 
Recorded files contain the complete survey solution (depth, position, and attitude data, including 
delayed heave). Line plans may also be generated, and a left/right helmsman indicator is displayed. 
 

Step 4. Data Processing 
The recorded s7k files should be processed using your software of choice (e.g. HYPACK, Qimera, 
CARIS, etc.). Here, patch test results and sound velocity profiles can be applied or refined, and the 
geodetic setup is defined. 
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5.2 HYPACK 

Refer to the HYPACK manual for comprehensive guidance and note that the setup described below 
is based on HYPACK 2025. With integrated NORBIT sonars, all systems (navigation, attitude and 
multibeam) should have the same offset applied, as measured from the vessel centre of gravity to 
the Sonar Reference Point, while the vertical offset should be measured from the waterline. The 
HYPACK sign convention uses +Forward, +Starboard, and +Down. 
 

Step 1. Configure HYSWEEP Extended Interface 
Add HYSWEEP Extended Interface from the Survey Devices list and enable all the function 
checkboxes (Position, Depth, Heading, Tide and Heave/Pitch/Roll). 
 

  
 

 
 

Step 2. Configure Clock Synchronization 
Select Hardware on the left pane and then, on the System tab, select HYSWEEP Extended Interface 
as the device to synchronize the computer clock.  
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Step 3. Define Boat 
Select Boat and assign a name. For more intuitive visualisation, add a tracking point, preferably to 
the Sonar Reference Point (for standard installations). Edit the Vessel Shape as appropriate. 
 

  
   

Step 4. Configure Multibeam Device 
Select HYSWEEP Devices and add NORBIT WBMS from the list. On the Connect tab, the Internet 
Address should be set as the IP address of the PC running the NORBIT GUI. 
 

 
 

  
 
On the Setup dialog, enable the Use Pass Through Position, Heading and MRU option. This provides 
the navigation solution, simplifying the setup by removing the need for the Applanix POS/MV  or SBG 
Network devices that were required in previous versions 
of HYPACK. 
 
Optionally, select Sidescan Recording (for recording 
Sidescan data), Snippet SS Recording (for Snippets-
Sidescan), or Snippet Recording (for Snippets). If 
Snippets is requested, users must also select Log 
Datagrams. 
 
Note that bathymetry data automatically includes bathy 
intensity values at the bottom detection point, which 
provides coarse backscatter. 
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5.3 Qinsy 
The described configuration of Qinsy v9 assumes that the INS reference is collocated with the Sonar 
Reference Point. The Qinsy sign convention uses X+ Starboard, Y+ Forward and Z+ Up. 
 

Step 1. Configure Geodesy 
Access the Geodetic Configuration from the Qinsy console and specify the relevant geodesy. 
 

Step 2. Object Definition 
From the Qinsy console, select Setup > New Database Specify the shape of the vessel and the 
reference point for Qinsy (e.g. vessel centre of gravity) 
 

  
 

Step 3. Add Multibeam System 
Specify a system name, e.g. NORBIT, and select Multibeam Echosounder as the type. Select the 
Reson SeaBat 7k (TCP/Network) driver, use port 7000 and IP address 127.0.0.1 (unless the GUI is 
installed on a different PC, in which case use the local network address). 
 

  
 
Under Raw Data Recording, for standard bathymetric data collection select the NORBIT System and 
None for Packet Storage, Water Column and Snippets. 
 

Step 4. Configure Snippets and/or Water Column Recording (Optional) 
To collect water column, select the 7042 (Compressed) option. To collect snippets without water 
column, configure the system as shown below (left); or for snippets and water column (right) 
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Step 5. Enter Offset to Sonar Reference Point 
In Multibeam Echosounder Parameters, click the + button to generate a node. Patch test values (roll, 
pitch and heading) should be entered if known. Enter 1024 under max beams per ping. Use the 
default echosounder accuracy and correction values. The offsets shown are an example only. 
 

  
 

Step 6. Add Side Scan System (Optional) 
To add side scan, a port and starboard channel should be added, and the frequency should also be 
specified. Items marked with an asterisk (*) will not impact the data and are only for record keeping. 
 

   
 

Step 7. Add Delayed Heave System 
To record delayed heave, add the Network - POS MV V5 (Binary Group 111 - True Heave) system 
(for Applanix models) using port 5602, or the Network (UDP) - SBG Systems Delayed Heave UTC 
option (for SBG models) using port 1234, found under the Miscellaneous System category. 
 
Delayed heave is logged to a .bin / .txt file in the Import directory of the project and can be applied 
in post-processing to replace real time heave. Delayed heave is more accurate and is logged with a 
3-minute delay. This means that Qinsy must remain open for 3 minutes at the end of the survey. 
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Step 8. Add Pitch/Roll/Heave System 
From the Database Setup window, add a new Pitch/Roll/Heave sensor, using the Reson SeaBat 7k 
(TCP/Network) R-P-H driver and the same port number and IP address as in the previous steps. 
 

     
 
Step 9. Add Gyro Compass System 

Repeat the previous step to add a new system, but this time select Gyro Compass. The latest 
versions of Qinsy allow users to specify the slot number. If you see this option, select HDG1. 

 

   
 

Step 10. Add Position Navigation System 
Repeat the previous step to add a new Position Navigation System. The datums will depend on the 
project specifications. For older versions of Qinsy, the receiver number should be 0. For newer 
versions, the slot options POS and NAV are available, and either can be used. 
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Step 11. Add Time Synchronisation System 
Add a time synchronisation system, as per below. No PPS adapter is necessary. 
 

   
 

Step 12. Configure Qinsy Online Filters 
Enable a Range filter (minimum 0.5m) and Brightness/Collinearity 
filters. This is set under Controller > Settings > Echosounder Settings 
in Qinsy Online and removes the false trail of soundings at nadir which 
have 0m range and quality flag zero. 
 

⚠ 
NOTE: Red time synchronisation alerts in Qinsy Online are generally not a 
concern, as all data is time stamped at source. These alerts can safely be 
ignored. 

 

5.4 PDS 
Force Push must be enabled in the Connection menu to receive data in PDS (see section 4.8.6). The 
PDS sign convention uses Y+ Forward, X+ Starboard, and Z+ Up. For integrated Applanix systems, 
the Ethernet output groups required by PDS are automatically configured on the NORBIT system, 
thus no action is required. 
 

Step 1. Create New Project and Setup Geodesy 
Create a new project in PDS Control Centre via File > New Project. Specify a name for the project, 
and on the next page select a coordinate system from the geodatabase or define a new coordinate 
system according to the survey requirements. 
 

  
 

Step 2. Select Application Type and Run Configuration Wizard 
Select Multibeam Acquisition as the application type. Click Next and run the configuration wizard. 
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Step 3. Add New Vessel 
Specify a name for the configuration (e.g. “Survey Vessel Pole Mount”) and on the next page add a 
Local vessel which will contain all relevant drivers and offsets. 
 

Step 4. Enter Offsets 
On the Geometry tab, define the shape of the 
vessel (only for display) and enter the Centre 
of Gravity offset measured from the Sonar 
Reference Point. Leave the CoG Z field zero to 
keep the setup simple, as the Sea Level offset 
is defined in relation to the CoG. Then enter 
the Sea Level offset relative to the Sonar 
Reference Point as a positive value. 
 
If the optional iLiDAR is installed, add its 
offset to the list. This is the measured offset 
from Sonar Reference Point to iLiDAR 
Reference Point. 

 
Step 5. Add Essential Devices 

Devices for each data type are added on the Equipment list. On the left side, select the Group and 
select the driver to add. As a minimum, the following drivers are required: 
 

For systems with integrated Applanix GNSS/INS… 

Group Driver I/O Port Offset 

Positioning system 
Geogs 

PosMV all coupled modes- ethernet msg 
3+10+12+20+102+104[pos] 

UDP 5602 Zero Offset 

Compass PosMV ethernet 3+102+104[hdg] UDP 5602 Zero Offset 

VRU PosMV ethernet 3+102+104[vru] UDP 5602 Zero Offset 

Multibeam NORBIT using RESON 7k protocol (1) [mbs] 127.0.0.1, TCP 7000 Zero Offset 

 

For systems with integrated SBG GNSS/INS… 

Group Driver I/O Port Offset 

Positioning system 
Geogs 

SBG Systems 08[pos] UDP 1234 Zero Offset 

Compass SBG Systems 06[hdg] UDP 1234 Zero Offset 

VRU SBG Systems 06[vru] UDP 1234 Zero Offset 

Heave SBG Systems 09[heave] UDP 1234 Zero Offset 

Multibeam NORBIT using RESON 7k protocol (1) [mbs] 127.0.0.1, TCP 7000 Zero Offset 

Note: It is assumed that the NORBIT GUI and PDS are installed on the same PC, therefore 127.0.0.1 is 
configured for the multibeam driver. Otherwise, the local network IP address of the GUI PC must be entered. 

 
Step 6. Add Optional Devices 

Optional drivers may be added for snippets, side scan, delayed heave, or LiDAR data:  
 

Group Driver I/O Port Offset 

Snippets NORBIT using RESON 7k protocol (1) [snp] 127.0.0.1, TCP 7000 Zero Offset 

Sidescan Sonar NORBIT using RESON-7k protocol (1) [sss] 127.0.0.1, TCP 7000 Zero Offset 

Heave (Applanix) PosMV ethernet 3+111[heave] UDP 5602 Zero Offset 

Heave (SBG) SBG Systems Delayed 32 UDP 1234 Zero Offset 

Laser Scan Velodyne LiDAR VLP-16[laser-scan] UDP 2368 iLiDAR 
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Step 7. Configure I/O Ports 
Select each device on the Equipment list and click I/O Port to configure the interfacing parameters, 
as per the tables in the previous sections. Configure the IP addresses and port numbers correctly 
based on whether the system contains an integrated Applanix or SBG GNSS/INS. 
 

    
 

Step 8. Configure Device Properties and Apply Offsets 
For each device on the Equipment list, click Edit to open the Device Properties. Here you must select 
the offsets to apply, as defined previously on the Geometry setup. Recall that all applied offsets 
should be zero, except the optional iLiDAR. The patch test values, if known, may be entered in the 
device properties for the multibeam and optional iLiDAR. 
 

   
 
Step 9. Configure Optional LiDAR Properties 

If the optional iLiDAR is installed, the orientation base must be set in device properties. This should 
be set to Down-Across assuming the scanner is installed in the standard configuration with 
connector aft. Refer to the PDS manual for more details. 
 

Step 10. Configure Height Source 
Select Reference Point Computation under the positioning 
device and double click, or press Edit. The height source 
can be set to GPS Height [RTZ] if RTK positioning is 
available, otherwise, set this to None. 
 
Height Standard Deviation Mask is a user-defined quality 
threshold for utilising RTK heights in the depth calculation. 
By default, it is set to 0.1m, which means that the GPS 
Height source will only be applied if the altitude quality reported by the sensor is <0.1m. 

 
Step 11. Complete the Wizard 

Now the essential steps are complete. The next pages of the wizard contain optional setup steps, 
details of which are available in the PDS manual. Finish the wizard to return to PDS Control Centre. 
To return to these settings and modify the vessel configuration, click the gear icon on the toolbar.  

 

Applanix Devices Multibeam Device iLiDAR 

Multibeam Properties iLiDAR Properties 

SBG Devices 
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5.5 BeamworX 
This section explains how to configure NavAQ for data collection with integrated NORBIT systems. 
Refer to the BeamworX manual for comprehensive guidance. 
 

Step 1. Create Survey Configuration 
In NavAQ, select File > New Survey Config, and select the NORBIT STX template for single head, or 
NORBIT DUAL for dual head. This adds the required devices for NORBIT integrated systems. 
 

 
 

Step 2. Remove Redundant Devices 
If the iLiDAR is not used, this device can be removed. BeamworX can retrieve INS data directly from 
the 7k record stream for integrated NORBIT systems, therefore the Applanix POS MV devices can 
be removed. Alternatively, the Norbit-Pos and Norbit-MRU[Attitude] devices can be removed. 
 

Step 3. Configure Computation Settings 
Under computation settings, select which devices to use 
for Positioning, Heading, and Pitch/Roll/Heave based on 
the devices that were added in the previous steps. The 
Height Mode can also be configured here. 

 
Step 4. Configure Device Settings 

Configure the IP Address and Port settings for each device. When the Applanix device is added (i.e. 
when not using INS data from the 7k data stream), it should interface to UDP port 5602. The 
multibeam device interfaces to the IP address of the GUI PC (typically 127.0.0.1) on TCP port 7000. 
 

   
 

Step 5. Configure Offsets 
For systems which support pitch or yaw stabilisation, BeamworX recommends defining Separate 
TX/RX offset locations to increase the accuracy of the footprint calculation. Otherwise, the 
Combined TX/RX model should be selected for the multibeam device. 
 

Step 6. Configure Backscatter 
To collected snippets backscatter data, select the Snippets (7028) backscatter option in the 
multibeam device settings. The Per Beam Intensity option can also be used, to record single 
intensity values at the bottom detection point (a form of coarse backscatter). 
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5.6 NaviSuite 
This section describes a typical setup for NaviPac and NaviScan using a NORBIT system with 
integrated Applanix GNSS/INS. It may be necessary to enable Force Push, as described in section 
4.8.6, to receive data into NaviScan. The sign convention uses X+ Starboard, Y+ Forward, and Z+ 
Up. Refer to the NaviSuite software guides for comprehensive guidance. 

 NaviPac 

Step 1. Configure POSMV IF Module 
The POSMV IF Module is required to send Applanix UDP data to NaviPac and NaviScan: 
https://eiva.freshdesk.com/support/solutions/articles/43000565394-navipac-posmv-if-module 
 

Step 2. Add Surface Navigation, Gyro and Motion Instruments 
Add a Surface Navigation instrument to the vessel. Select POSMV Group 1 from the list and use IP 
address 127.0.0.1 with the correct UDP port as set in POSMV IF. Repeat this step for Gyro and 
Motion, using POSMV Gyro 102/3 and POSMV RPH 102/3, respectively. 

 

   

 NaviScan Config 

Step 3. Enable Automatic Packet Subscription 
In Options > Global Parameters > MBE/SS, enable the Norbit 7k always subscribe option. NaviScan 
will then automatically subscribe for packets when the connection port differs from 7000. 
 

 
 

Step 4. Add Navigation Sensor 
Begin by adding the navigation sensor. Go to Equipment > Add Sensor and select the Applanix 
option. For port settings, enter the IP address 127.0.0.1 (if NaviPac and NaviScan are installed on 
the same PC), and the UDP/IP Port as defined in POSMV IF. 
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Step 5. Add Gyro Sensor and Motion Sensor 
Repeat the previous step to add the Gyro sensor and Motion sensor. Select the Applanix options and 
configure the network settings as per the previous step, noting that the UDP port for each sensor 
depends on the POSMV IF configuration. 
 

   
 

Step 6. Add Echosounder 
Add an Echosounder, selecting the Norbit RawRange 7027 option. In port settings, select TCP/IP 
Port, enable Local if the NORBIT GUI and NaviScan are installed on the same PC, and use port 7000 
(unless configured otherwise in the NORBIT GUI). For dual head operations, select the Norbit 
RawRange 7027 Dual option. 
 

   
 

Step 7. Time Synchronisation 
If NaviPac and NaviScan are on the same computer, Ethernet timing can be used for time 
synchronisation. Add a GPS Time sensor and select the Applanix option, using the same port 
settings as the other Applanix sensors. The final NaviScan project tree is shown below. 
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 NaviSuite Kuda Core 

This section describes a typical setup using a NORBIT system with integrated Applanix GNSS/INS. 
Kuda Core is an entry-level software variant that simplifies the setup by combining the functions of 
NaviPac and NaviScan into a single interface. Note that POSMV IF is not required with Kuda Core. 

 
Step 1. Add Surface Navigation, Gyro and Motion Instruments 

Add a Surface Navigation instrument to the vessel and select the ApxPosmvPos option. Configure 
the port to 192.168.53.100 on UDP 5602. Repeat this step for Gyro and Motion, selecting the 
ApxPosmvGyro and ApxPosmvRPH options, respectively. 
 

   
 

Step 2. Add Time Synchronisation Instrument 
Repeat the above step to add a time synchronisation instrument. From the Other category, select 
the Pos mv GPS time option, and use the same Port setup as the previous instruments. 

 
Step 3. Add Echosounder 

Add an Echosounder, selecting the Norbit RawRange 7027 option. Configure the port to localhost 
(127.0.0.1) if the GUI and NaviSuite are installed on the same PC, on TCP port 7000 (unless 
configured otherwise in the NORBIT GUI). If the GUI and NaviSuite are installed on different PCs, the 
IP address should be configured to the address of the GUI PC. For dual head operations, select the 
Norbit RawRange 7027 Dual option. Snippets and/or sidescan instruments can also optionally be 
added from the Sidescan category, using the same port settings as the Echosounder. 
 

  
 

Step 4. Enable Automatic Packet Subscription 
In Project Settings > Instrument Extra, enable the Norbit 7k always subscribe option. The software 
will then automatically subscribe for packets when the connection port differs from 7000. The port 
is set to 7000 by default in the NORBIT GUI but can be changed to any number by the user. 
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 Maintenance 

6.1 Caring for Your Investment 

 Handling & Shipping 

• Handle the sonar with care and use "Fragile" labels for shipping. Ensure it is properly supported 
and avoid lifting or carrying the sonar by the sound speed probe or projector. 

• Do NOT allow the sonar to rest on the polyurethane, and place sturdy padding (foam) under the 
sonar when mounting to prevent scratches. 

• The Inertial Measurement Unit (IMU) on integrated models contains sensitive solid-state 
accelerometers and gyros. Rough handling can damage these components. 

• For standalone WINGHEAD X or WBMS X sonars, if shipping in a non-foam cut case, remove the 
SV sensor and replace it with the dust cap. When removing the sensor, orient the sonar so that 
the SV socket faces horizontally to prevent water on the wet sensor from entering the socket. 
Ensure the socket is completely dry before re-attaching the sensor. 

• Some WINGHEAD models contain sound speed probes which are tightly integrated and NOT 
field-swappable. These probes cannot be removed and attempting to do so will damage the 
system. For information on the field-swappable option, refer to Appendix B3. 

 Operational Use 

• Do NOT operate the sonar in air for extended periods, as this may cause overheating and 
permanent damage. The sonar must be fully submerged in water during normal operation. 
Functional checks performed in-air must be brief, with Pulse Amplitude set to 0. 

• Keep the sonar out of prolonged direct sunlight to protect the polyurethane coating on the 
transducers from UV damage, which can cause brittleness and cracking formations. When pole-
mounted systems are recovered, the sonar should be covered with a protective bag or similar. 

• To protect the system electronics, always turn off the power before disconnecting or swapping 
cables. Do NOT connect or disconnect cables when the system is powered on. 

 Submersion Guidelines 

• The SIU has an IP67 ingress protection rating. This rating is intended to provide protection 
against accidental exposure only and does not imply suitability for intentional or prolonged 
submersion. It also assumes that all connectors are properly sealed with cables or dust caps. If 
the SIU is exposed to salt water, it must be promptly cleaned and dried thoroughly. 

• Extended submersion risks biofouling (especially in warm salty water) or subjection to stray 
electric currents. NORBIT offers titanium housing, additional anodes (for aluminium models) 
and factory applied antifouling coating that is tested against acoustical losses. 

 Post-Use Cleaning 

• Clean the sonar with mild, non-abrasive soap, fresh water, and a soft brush. Do NOT use a 
pressure washer. Rinse and dry the sonar thoroughly after use, especially in saltwater. For 
models with aluminium housing, handle the anodised housing carefully to prevent scratches. 

• For instructions on removing marine growth, refer to section 6.2. 

 Antifouling 

• When the system is coated with NORBIT’s approved ClearSignal antifouling coating, handle it 
with extra care to preserve its effectiveness. After retrieval, wipe the sonar with a clean towel to 
remove any dirt or grime. 

• For instructions on removing marine growth from antifouled systems, refer to section 6.2.2. 
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6.2 Marine Growth Removal 

 Standard Procedure 

Remove the sonar from the vessel and secure dust resistant caps on the bulkhead and cable. 
Remove as much fouling from the sonar as possible by hand. 
Fill a large bucket with clean fresh water. 
With the bulkhead cap tightened, submerge the sonar for 2 hours to soften the marine growth. 
Remove and scrub the sonar using fresh water and a soft, non-abrasive tool (e.g. plastic scraper). 
Repeat the soaking process, if necessary, until all biofouling has been removed from the system. 
Allow the system to dry fully prior to storage. 

 
 

⚠ 
CAUTION: Do NOT use pressure washers to clean the sonar, as it may damage 
the sensitive arrays. Only scrub the sonar using super-fine, non-metallic abrasive 
pads, such as 3M™ Scotch-Brite™ Light Cleansing Hand Pad 7445, or soft plastic 
or wooden scrapers. Do NOT use metal tools or sharp objects. 

 

 Systems Coated with ClearSignal Antifouling 

Remove the sonar from the vessel and secure dust resistant caps on the bulkhead and cable. 
Avoid using highly abrasive and chemical cleaning methods. 
Clean the sonar using a wet kitchen-type sponge, using the soft or abrasive side of the sponge. 
Use generous amounts of water to wash away the removed fouling. 
Soapy water can be used for cleaning and will aid in the removal of biofouling. 
Allow the system to dry fully prior to storage. 

 

6.3 Maintenance Schedule 

 Before Each Survey 

Component Inspection Additional Notes 

Receiver Array Inspect the polyurethane for any gouges, nicks or 
separation from the housing. Ensure the array face 
is smooth and uniform. 

Water intrusion can cause 
damage and lead to costly 
repairs. Store the sonar away 
from direct sunlight. 

Projector Array Inspect the projector array for any gouges or nicks 
and check the attachment area where the projector 
connects to the sonar housing. The surface should 
be smooth and uniform. 

Water intrusion can cause 
damage and lead to costly 
repairs. Store the sonar away 
from direct sunlight. 

O-Rings on 
Wet-End Cable 
Connections 

Check the O-rings for damage and any particulates 
that could interfere with their operation. Keep the 
O-rings lightly lubricated with silicone grease that 
is at least 90% pure. DO NOT apply grease to the 
connector pins. 

If a spare O-ring is missing, 
borrow one from the cable wet-
end protective cap and contact 
NORBIT Support for 
replacements. 

Sound Speed 
Probe 

For sonar models containing a field-swappable 
probe (e.g. WINGHEAD X and WBMS X), unscrew 
the probe and inspect the connector for corrosion.  
 

SV probes on some WINGHEAD 
models are tightly integrated and 
can NOT be removed, and 
attempting to do so will damage 
the system. A detachable SVP 
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When removing the sensor, orient the sonar so that 
the SV socket faces horizontally to prevent water 
on the wet sensor from entering the socket. 
Ensure the socket is completely dry before re-
attaching the sensor. 
 
Ensure the O-ring is in good condition before 
reinstalling the sensor tightly, then compare the SV 
value with the SV profiler at the same depth. The 
difference should not exceed 1m/s. 

option is available for such 
models (see Appendix B3). 
Incorrect or missing sound speed 
data causes beam steering 
errors and affects outer swath 
performance. Calibrate the probe 
every 24 months. 

Sonar Housing Inspect the housing for scratches and corrosion.  
Ensure the anode is in good condition for 
aluminium models. 

Small scratches compromise the 
galvanic barrier of the aluminium 
housing. 

Sonar 
Connector 

Check for debris and clean with compressed air. 
Ensure the cable connector is dry and clean and 
use a protective cap when the connector is not in 
use. 

The sonar connection is not wet-
mateable. Do not disconnect or 
connect the sonar when it is 
submerged or in wet areas. 

Sonar Cable Clean the connectors with compressed air, and 
ensure the cable is smooth and free from kinks 
and tears. Check the pins are shiny and straight. 
Inspect the O-rings for wear and replace if needed. 
Apply a small amount of silicone lubricant. 

A bad connection or damaged 
cable will corrupt survey data. 
Handle the cable with care (do 
not stand on it). 

Sonar Mounting 
Bolts 

Verify that the threads on plastic sleeves are intact 
and not de-threaded. Long-term vibration can 
loosen bolts, which may compromise data quality 
or result in wet-end loss. 

Use only stainless-steel bolts and 
washers. Apply Loctite 242 Blue, 
lock washers and/or nylon nuts 
to secure the bolts. 

Mounting 
Bracket 

Ensure all hardware on the mounting bracket is 
tight. Be cautious when checking the mounting 
screws for the sonar, as over-tightening can 
damage the connections. 

The bracket is robust and 
provides electrical isolation from 
the vessel. 

Firmware & GUI 
Versions 

Ensure that both the firmware and GUI versions are 
up to date and match each other. For integrated 
systems, this may involve an annual maintenance 
cost for the INS component. 

Contact NORBIT Support for 
further details. 

 After Each Survey 

Component Inspection Additional Notes 

Complete Kit Perform all inspections from the previous section.  Store the system in a dry location 
at room temperature. 

Wet-End Rinse the wet end with fresh water and clean off 
marine growth with a soft rag. Remove barnacles 
carefully to avoid pitting or nicking the 
polyurethane. Send photos of any damage to the 
anodised aluminium or polyurethane to NORBIT 
Support. Allow the kit to dry before storing, and 
store with the lid open once back at the office. 

When not in use, secure the 
sonar cable with the included 
protective caps. Adjust the length 
by grabbing one of the collars 
and pulling on the cable. 

 Monthly 

Component Inspection Additional Notes 

Complete Kit Perform all inspections from the previous sections.  Ensures readiness for the next 
survey. 

Sound Speed 
Probe 

Compare the surface sound speed probe with 
another sensor. If the difference exceeds 1m/s 
under similar conditions, identify the faulty sensor 
and return it for calibration. 

The surface sound speed sensor 
should provide reliable data for a 
24-month period. 
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 Annually 

Component Inspection Additional Notes 

Complete Kit Perform all inspections from the previous sections. 
NORBIT offers factory or on-site system health 
checks. The factory health check is recommended 
every two years for a full system inspection and 
performance scan, while the on-site check is more 
limited. 

The factory service includes 
surface sound speed calibration. 

Contact NORBIT Support to 
schedule a factory health 
check. It is the responsibility of 
the user to schedule the service. 

 

6.4 PORTUS Pole Tool Bag Contents 

Item Qty A* Qty B* 

Tool Pouch 1 1 

Safety Line (5m) 1 1 

Gear Ties 4 4 

Silver Permanent Marker 1 1 

5/8” 0.12” Rubber Washer 2 0 

5/8” ASME B18.21.1 Exter. Tooth Lock Washer 2 0 

GNSS End Caps 20149P017-4 2 0 

M6 x 12mm DIN580 Eye Bolt 2 2 

M8 x 80mm Ball Lock 2 2 

M8 x 60mm Ball Lock 2 2 

M6 x 39mm Ball Lock 2 2 

M8 x 90mm DIN912 A4 Cap head Screw 2 1 

M8 x 30mm DIN931 A4 Hexagon Bolt 4 4 

M8 x 30mm DIN912 A4 Cap Head Screw 4 4 

M8 From A DIN123 Flat Washers 12 10 

M8 DIN985 A4 Nylon Locking Nuts 10 9 

M8 DIN127B A2 Spring Washer (short term use only) 6 6 

M8 DIN315AF Wing Nut (short term use only) 6 6 

M6 x 25mm DIN7991 A2 Socket Screw 2 2 

M8 x 30mm GN927.5-82 Levers 0 2 

 
*A: When purchased with PORTUS Pole 
*B: When purchased as standalone tool bag 
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 Troubleshooting 

7.1 Sonar 

Problem Solution 

System does not 
behave as expected 

• Select Set Sonar Factory Defaults (see section 4.8.6.1). 

• Obtain the latest GUI installer from NORBIT Support. 

Firmware 
compatibility warning 

• Ensure that the latest GUI is installed, and if required, update the sonar 
firmware as described in section 4.4. 

No sonar connection • Check and secure all cables. If the wet-end connection is loose, remove the 
connection, clean the threads at both the male and female fittings, then apply 
a very small amount of (approved) O-ring grease and re-tighten. 

• Reboot the PC, wait 30 seconds, then power-cycle the system. 

• Check for IP address conflicts. The PC network adapter should be configured 
to 192.168.53.XXX (where XXX is NOT in the 100-110 range, nor equal to the 
last 2 digits of the sonar serial number). See section 4.2. 

• Bypass network switches and connect the SIU directly to the PC. 

• In Windows Command Prompt, type ping 192.168.53.XX (where XX is the 

last 2 digits of the sonar serial number) to verify network connectivity. 

• Allow GUI and BathyProxy in Windows Firewall. 

Power-up failure or 
power loss during 
operation 

• Check the power supply voltage with a voltmeter. See section 2.1. 

• Inspect the battery/inverter for failure and replace if necessary. 

• If the supply voltage is outside the permitted range, the SIU Power LED blinks 
at 5Hz. Verify the power input using a known-good, stable power source. 

Display freezes or 
data packets dropped 

• The sonar output stops when the SV probe is detected ‘Out of water’. This is 
a protection measure to prevent damage to the electronics. 

• Check Windows Task Manager for excessive network bandwidth usage. 

• Replace the network cable or switch where applicable. 

• Update the computer network adapter driver. 

• Select Set Sonar Factory Defaults (see section 4.8.6.1). 

Data quality issues 

(e.g. motion 
artefacts) 

• Ensure that the installation is completely rigid and free from vibrations. 

• Ensure that there is no independent movement between the GNSS antennas 
and review the antenna separation distance (2m is recommended). 

• Review offsets and positioning quality. RTK corrections are recommended. 

• Verify that the primary GNSS antenna is connected to the Ant 1 SIU socket. 

• Check the sonar head for marine biofouling (see section 6.2). 

• Check for acoustic interference from other sensors, bubbles, or machinery. 

• Ensure that multiple network cards (e.g. Wi-Fi and wired) are NOT on the same 
static IP range. This causes duplication of navigation data. 

• For standalone systems, ensure the same PPS signal edge is used by both the 
SIU and the third-party GNSS/INS supplying the timing signal. 

• See section 7.3 for guidance on maximising data quality. 

Invalid sonar 
date/time (red) when 
using IRIG-B (ZDA and 
1PPS) timing 

• Inspect the pins on the cable and SIU. If a pin is bent, VERY gently bend it back, 
being careful to avoid further damage. Proceed at your own risk. 

• In INS Tools > Sky Plot, check that GNSS satellites are detected. 

• Check that the PPS LED on the SIU blinks at 1Hz (see section 2.3.4). 

• Perform a factory reset of the integrated INS (see section 4.6.1.1). 

• For Applanix models, verify that COM2 is configured to output $GPZDA at 1Hz, 
115200 baud, in the AP+ Web UI, or COM4 at 9600 baud in POSView (legacy 
models). For SBG models, Port D is configured in a similar manner. 

• For subsea ROV/AUV installations, NTP+PPS timing is recommended. 
Consult TN-190041 for full guidance on the timing requirements. 

“Sonar timing 
incorrect” error 

• This may happen if the integrated INS boots-up slower than the sonar. 
Acknowledge the error and continue to monitor it. 

• If the timing is incorrect, the date/time in the GUI appears red. 
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SV sensor reports 
‘Out of water’ or 
incorrect values 

• For models containing a field-replaceable SV sensor, verify and tighten the 
connection. On some models, the SV sensor is tightly integrated and CANNOT 
be unscrewed, and attempting to do so will damage the sensor. 

• Stop the vessel to allow air bubbles to dissipate. If required, adjust the 
mounting to reduce bubble formation. 

• Verify the raw SV sensor data in the Web UI Diagnostics page 
(http://192.168.53.XX:8080, where XX is the last 2 digits of the serial number). 

• Inspect the SV sensor for damage or marine growth. 

Sounding gaps in data • Adjust the Adaptive Gates to a wider setting. See section 4.8.5. 

• Ensure that the seabed is between the Upper Gate and Lower Gate. 

False detections at 
nadir with 0m range 

• Apply brightness and collinearity filters, and/or 0.5m minimum range filter in 
the data acquisition and processing software to remove false soundings. 

Seabed not detected • Move the Upper Gate closer to the expected bottom to bypass surface noise. 

• Ensure that the Lower Gate is beyond the expected maximum depth. 

Stabilisation status 
(roll, pitch or yaw) is 
red 

• For integrated systems, ensure the INS is detected by the GUI and reporting 
valid attitude data. If not, power cycle and review Windows Firewall settings. 

• For non-integrated systems, follow the instructions in section 4.6.8, and use a 
terminal emulator such as PuTTY to verify the TSS1/EM3000 data stream. 
Select “Serial” type connection, enter the port number and baud rate, and 
select Open to display the data stream. 

Licensed features not 
available 

• Ensure that the sonar GUI and firmware is up to date. 

• Follow the activation instructions described in Appendix B1. 

Data not received in 
acquisition software 

• Disable both Private and Guest or public firewalls. 

• Ensure the acquisition software has the correct IP address and ports. For 
sonar data, the acquisition software must connect to the IP address of the 
NORBIT GUI PC (usually 127.0.0.1) and not the IP address of the sonar itself. 

• Ensure that the GUI reports valid sonar timing. 

Dual head secondary 
data not received in 
acquisition software 

• Sentinel dongles (e.g. Qinsy license dongles) occupy port 7001, which is also 
the default port of the secondary sonar. 

• To avoid conflict, change the primary port number in the GUI Connection 
settings to 17000, for example (see section 4.8.6). 

Data not received in 
PDS or EIVA NaviScan 

• Ensure that Force Push is enabled under the Connection menu in the GUI (see 
section 4.8.6). 

Backscatter mode is 
greyed out 

• TCP/IP subscriptions from the data acquisition software (such as Qinsy or 
HYPACK) overrides the GUI selection. This is normal. 

Cannot steer swath to 
waterline 

• Ensure that Equiangular beam spacing is used. Detections in Equidistant 
modes are limited to 10° from horizontal. 

Text in GUI appears 
condensed 

• In Windows settings, go to System > Display and adjust the Scale setting. 

• Right-click the GUI desktop shortcut, open the Properties, and select Change 
high DPI settings on the Compatibility tab. Change the High DPI scaling 
override setting to System. 

s7k file sizes are too 
large 

• The file size limit can be controlled by editing this file: C:\Program Files 
(x86)\Norbit AS\WBMS\config\factory_wbmsgui.ini 

• In the [S7kFiles] section, size_limit_MB controls the maximum file size 

in megabytes, e.g. size_limit_MB=1024 will split the s7k file every 1GB. 
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7.2 Integrated INS 

Problem Solution 

INS not detected 
in the GUI 

• Disable Windows Firewall, or allow GUI access and add a port exception: 
▪ Open legacy Windows Control Panel and go to System and Security > 

Windows Defender Firewall. 
▪ Choose Advanced Settings on the left menu. Create a new Inbound Rule, 

select Port and click Next. 
▪ Apply the rule to UDP port 5602 and click Next. 
▪ Select Allow the connection and click Next. 
▪ Apply the rule to Domain, Private and Public, and click Next. 
▪ Specify a rule name and Finish the wizard. 

• For SBG models, add exceptions for UDP port 1234, TCP ports 50000 and 50001.  

• For Applanix models, ensure that POSView is closed or in Monitor mode, then 
restart the NORBIT GUI. 

• In Windows Command Prompt, type ping 192.168.53.100 (Applanix models) 

or ping 192.168.53.103 (SBG models) to verify network connectivity. 

• Review the network configuration (section 4.2) and check for IP address conflicts. 
Change it to 192.168.53.150, with subnet mask 255.255.255.0. 

• Inspect all cables and connectors, ensuring that the connections are tight. 

• Low quality power supplies may cause this issue. Try an alternative power source. 

• Perform a factory reset of the integrated INS (see section 4.6.1.1). 

GNSS data not 
received 

• Check the antenna cables and ensure that all connections are secure. 

• Use only the antennas provided with the kit and ensure that they have a clear sky 
view with no obstructions. Unsupported antennas may not work. 

INS Wizard fails 
to update 

• The error “Failed to connect to the POS MV Control port” on Applanix models 
indicates that POSView is open and Connected. POSView is not required for 
integrated systems. At a minimum, it should be in Monitor mode during operation. 

RTK corrections 
not received 

• For serial RTK data, check the COM port settings and cable connections. Check the 
radio link and frequency, ensuring that the baud rates and corrector types match. 

• If required, use a Null Modem adapter on the serial connector to swap pins 2 and 3. 

• For serial RTK data, use a terminal emulator such as PuTTY to verify the data 
stream. Select “Serial” type connection, enter port number and baud rate of data 
source, and select Open to display data stream. 

• For NTRIP solutions, verify the credentials and check the Internet connection. 

RTX/Marinestar 
corrections not 
received 

• Ensure that Trimble RTX or Marinestar is enabled in the INS Setup Wizard (see 
section 4.6.1.5). 

• Ensure that the correct satellite frequency and bitrate are configured for your region. 

• Under INS Tools > System Status, verify that: 
▪ The subscription is active with a valid expiry date shown. 
▪ The Status in the Marinestar Status or Trimble RTX Status block is reported 

as Tracking. 
▪ The SNR is >35dB-Hz. If the SNR is ≤35dB-Hz, inspect the antenna cables 

and antenna placement, and ensure that there is no interference. 

• If the over-the-air (OTA) activation method failed, contact your service provider to 
re-send the activation, ensuring that the Status is Tracking during this period. 

• For Trimble RTX users, the activation code can also be applied manually to the 
GNSS receiver if the OTA method fails (see section 4.6.7). 

• For Marinestar users, check with your service provider that the correct subscription 
plan is activated, noting that Applanix AP+ models only support the G4+ service. 

Heading 
alignment fails 

• Ensure that RTK or PPP (Marinestar or Trimble RTX) corrections are received. 

• Ensure that the antennas are connected to the correct Ant 1/Ant 2 SIU sockets. 

• Verify the offsets and review the GNSS environment. 

• Ensure that the installation is completely rigid and free from vibrations. 

Red Faults LED 
and System 
Status alerts 

If any of the errors below are shown permanently, check the offsets and mounting 
angles, and check the raw GNSS data for cycle slips or interference. 
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• Accelerometer Bias or Gyro Bias: May indicate that the IMU is outside specification 
limits and requires service. Can also be caused by incorrect offsets. 

• Nav/Aligned Heading Rejected: The vector between the antennas has not been 
accurately determined by the Kalman filter. May flicker red during normal operation. 

• Pri. GNSS Observable Rejected: Similar to the above. 

• Invalid Installation Parameters: Usually caused by incorrect offsets, incomplete 
heading alignment, or low satellites. If error persists, reboot system. 

• Bad IMU Frames: Should always be zero. If number is increasing, it could indicate 
a cable problem or electronics error. 

INS Logging LED 
is red or orange 

• Perform a factory reset of the integrated INS (see section 4.6.1.1). 

• Disable Windows Firewall. 
• Reboot PC. 

SBG Web UI is 
unstable 

• If the system includes the split serial upgrade and the Web UI is unstable, ensure 
that ONLY the split serial cable (PN 33209) is connected to the SIU COM port. Do 
not connect other cables directly to this port. 

Recorded files 
(.000 or .T04) 
are too large 

• The maximum file size of GNSS/INS raw observable files is controlled via the ini 
file: C:\Users\<user>\AppData\Roaming\Norbit\wbmsgui.ini 

• A new file is automatically generated when the specified file size limit is reached. 

• The limit can be changed under the [ins_logging] section, by specifying 

logfile_max_size in bytes. For example, to change the file size limit to 64MB, 

use logfile_max_size=67108864 (i.e. 64 * 1024 * 1024) 

[ins_logging] 

logfile_max_size=67108864 

• If Set Sonar Factory Defaults is selected at any time, this modification is reset. 

 

7.3 Data Quality Checklist 
✓ Review Hardware Installation: Ensure that all sensors are fixed, rigid, and free from vibration. 

There must not be any independent movement of sensors. 

✓ Primary Antenna Location: Ensure that the primary antenna is closest to the NORBIT system 
and connected to the correct SIU port (Ant 1). 

✓ Offsets: Measure offsets correctly to the nearest 1cm or better, and check sign inputs. 

✓ Sensor Alignment: Ensure that the integrated system is closely aligned with the vessel 
centreline. Agreement to within ±0.5° is ideal. 

✓ Centre of Rotation: If the sonar and IMU are not mounted at the CoR, measure and apply this 
offset in the INS Setup Wizard to eliminate heave artefacts. 

✓ GNSS Corrections: Only Narrow Lane RTK is suitable for RTK tides, requiring a base station 
with a baseline of <20km. Position errors increase with distance from the base station. DGNSS 
is accurate only to about 60cm horizontally. Ideally use a post-processed kinematic solution. 

✓ Sound Speed: In many environments, sound speed varies more in the upper layer of the water 
column. Mounting the sonar lower helps to overcome errors related to unaccounted changes 
in sound velocity. Perform SV casts on a regular basis and compare them to the surface sound 
speed, ensuring that the difference does not exceed 1m/s. 

✓ Patch Test: Review multibeam roll, pitch, and yaw misalignments. Repeat measurements as 
and when required. Generally, roll should not vary by more than ±0.02°, pitch by ±0.1° and 
heading by ±0.5°. Perform a patch test every time the sonar and IMU are moved. 

✓ Swath Angle: Soundings are most accurate within ±70° from nadir (depth-dependent). 
Accuracy may extend beyond this where the beam footprint and incidence angle are small (e.g. 
looking up a steep slope). Soundings looking down-slope have larger footprints and higher 
incidence angles, so survey lines should generally be parallel to the bottom contour. 
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7.4 Change Sonar IP Address 
The sonar IP address can be changed on the Network Settings tab of the sonar Web UI: 
http://<sonar-ip>:8080 (for example: http://192.168.53.51:8080) 

 

⚠ 
CAUTION: Do NOT change the static IP range of WINGHEAD S-series sonars (e.g. 
i80S, B51S) with PN 24115. Only the last digit may be changed via the Web UI 
(i.e. 192.168.53.X). If an IP-range change is required, contact NORBIT Support for 
assistance. 

http://192.168.53.51:8080/
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Appendix A: Quick Start Guides 
A1. Single Head Installation 

 
1. Unpack and Inspect: Unpack sonar system and inspect all cables and connectors for damage, dirt and 

moisture. Inspect the transducers for cuts or gouges (see section 6). 

2. Sonar Installation: Mount the sonar parallel to the vessel keel 
with the projector pointing aft. Secure the bracket to the pole 
with at least 4 bolts, using lock-washers and/or Loctite 242, 
especially for longer deployments. Connect the wet-end 
cables prior to mounting (see section 2.4). 

3. Antennas: For GNSS/INS integrated systems, mount the GNSS 
antennas with 5/8” threaded bolts. While not essential, it is 
helpful to align the GNSS antennas parallel or perpendicular to 
the vessel keel (see section 2.4.6). The antenna closest to the 
sonar is typically the primary. Connect the primary antenna to 
Ant 1 on the SIU, and the secondary antenna to Ant 2. 

4. Cables: Run the cables from the sonar and antennas to the SIU. Avoid sharp bends and beware of 
chafing. Handle cables with care, as rough handling can bend, and damage, the connector pins. Do 
not run the cables next to high voltage lines and spread the cables out to avoid RF interference. 

5. SIU & PC: Connect the SIU to the PC via Ethernet. Set the IP address of the PC to 192.168.53.XXX, 
where XXX can be any number from 110 to 255, with subnet mask to 255.255.255.0 (see section 4.2). 

6. RTK: If RTK positioning is used, configure it as required. 

7. Offsets: For the default setup, measure the XYZ offsets from the Top Centre of Bracket to the bottom 
of the primary GNSS antenna. 

8. Power: Ensure that the power source is clean and beware of batteries that are under powered, or cheap 
inverters. See section 2.1 for more details. 

9. Software: Install the NORBIT GUI and disable Windows Firewall. Power on the SIU, launch the NORBIT 
GUI, and connect to the sonar via the Connection Dialog. Once connected, the GUI starts logging raw 
GNSS/INS observables automatically on integrated models. 

10. INS Setup: Open the INS Setup Wizard under INS Tools. Follow the prompts and enter the measured 
offsets. For the antenna baseline vector, select Alignment Wizard to ensure that the heading 
alignment starts automatically once the INS Setup Wizard is completed (see section 4.6.1). 

11. Acquisition: Set up your acquisition software of choice, e.g. DCT, HYPACK or Qinsy. Select the NORBIT 
driver (or Reson SeaBat 7125 network driver, if that is not available) and connect to the GUI IP address, 
which is typically 127.0.0.1, on TCP port 7000 (see section 5). 

12. Tides: Verify the INS system readiness by examining the RTK tide values for stability. As soon as the 
tide graph stabilises on a narrow value range, the system is ready for survey. 

13. Bar Check: Run a bar check to validate the sonar draft. 

14. Sound Speed: Verify the sound velocity reported by the sensor on the sonar by comparing it to another 
sensor, e.g. a sound velocity profiler. 

15. Online Filters: In your acquisition software, enable online filters to remove low quality soundings. 
Enable the brightness and collinearity filters, and if using Qinsy, enable a 0.5m minimum range filter 
to remove the false trail of soundings at nadir (which are recorded with 0m range). Flagged soundings 
can be recovered in post-processing, if necessary. 

16. Patch Test: Perform a patch test each time the sonar is installed or relocated. 
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A2. Dual Head Installation 

 
1. Mounting: For the standard dual head brackets (Appendix E), mount each 

sonar using M10x40-A4 screws. In general, avoid exceeding ±10° physical 
rotation to prevent water surface reflections in the acoustic signal. 
Secure the bracket to the mounting platform using suitably sized M10 
screws, using M10x60-A4 when mounting to a PORTUS pole. 

2. Cables: Secure and connect the cables, as shown in section 2.8. Each 
sonar must be connected to a separate SIU. 

3. Networking: Configure the IP address of the operator PC to 
192.168.53.XXX where XXX can be any number from 110 to 255, with 
subnet mask to 255.255.255.0, as described in section 4.2. 

4. Connection: Power on the system and start the NORBIT GUI. On the 
Connection Dialog, highlight both online sonars on the Known Sonars 
List, set the left (port side) sonar as Primary, ensure the Unlinked boxes 
remain unchecked, and click Connect (see section 4.8.6.1). 

5. INS Setup: For integrated models, complete the INS Setup Wizard, adjusting the offsets and IMU 
rotations accordingly if the integrated IMU is rotated. Refer to Appendix F for the standard dual head 
bracket offsets and consult technical note TN-190018 for custom arrangements. 

6. Sonar Controls: The main display shows two swaths, with the primary sonar on the left. All setting 
changes apply to both systems, and note that when side scan is enabled, the display combines data 
from both sonars. The Sonar Tilt automatically sets the secondary sonar to the opposite tilt of the 
primary sonar. Note that in Unlinked mode (not recommended), each sonar is controlled 
independently, allowing independent steering (Direction) control. 

7. Wedge Overlap: The percentage overlap can be controlled in the GUI under the View menu. The Sonar 
Tilt setting (under Advanced) should also be set to match the physical rotation of the sonars. 

8. Frequencies: When the centre Frequency is set under Tx Pulse Settings, the system automatically 
applies bandwidth above and below this value to prevent frequency overlap and crosstalk between 
sonars. A minimum range Resolution of approximately 1.1cm, with corresponding bandwidth, is used 
with 400kHz frequency in FM Short Range mode. When longer sweep times are used, the applied 
bandwidth is reduced accordingly to minimise range resolution (see section 4.8.4). 

9. Port Numbers: In the data acquisition software, the default port numbers are 7000 for primary and 
7001 for secondary. The secondary port is always one greater than the primary. Note that Sentinel 
dongles (e.g. those used by Qinsy) occupy port 7001, therefore the port in the GUI must be changed 
to avoid conflicts. For example, change the primary port to 17000 (see section 4.8.6). 

  

Dual Head WINGHEAD 
(±10° Roll, ±1° Pitch) 

Dual Head WBMS X 
(±10° Roll) 
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Appendix B: Optional Features 
B1. License-Controlled Features 
 

Feature 
WINGHEAD X 

WBMS X 
WINGHEAD 
B51S & i80S 

All Other 
Models 

Pitch Stabilisation 
Provides evenly distributed along-track sounding coverage by 
actively compensating up to ±10º of vessel pitch motion. 

● ✓ ○ 

Yaw Stabilisation 
Provides evenly distributed sounding coverage by actively 
compensating up to ±10º of vessel heading changes. 

● ● ○ 

Dual Swath 2048 Beams 
Increase along-track coverage, or increase survey speed, with 
dual ping transmission (offset ±1°), producing 2x 1024 beams. 

● ● ○ 

STX Scanning 
Directs the sonar to sweep the transmit beam along-track in a 
±10° sector to increase survey coverage (see section 1.2.3). 

● ● ○ 

Equidistant Beam Spacing 
Distributes the beams across the swath to maintain equal 
footprint spacing for consistent coverage. 

● ✓ ✓ 

512 Beams 
Increases the maximum number of beams to 512 per ping to 
improve across-track sounding density. 

● ✓ ✓ 

1024 Beams 
Increases the maximum number of beams to 1024 per ping to 
improve across-track sounding density. 

● ✓ ✓ 

Long Range1 
Allows longer transmit pulses to achieve extended range 
performance when operating at 200kHz frequency mode. 

● ✓ ○ 

Backscattering Strength Output (BSO) 
Provides absolute backscatter strength output, demonstrating 
how strong the bottom reflects transmitted signals. 

● ● ● 

  ✓  Standard   ● Licensed   ○ Not Supported 

 

License Activation Procedure 

1. Access the Sonar Web UI: http://192.168.53.XX:8080 (where XX is the last 2 digits of the serial number) 
2. On the License tab, select Set License File 
3. Select the *.lic file provided by NORBIT to activate the license, then restart the NORBIT GUI. 

 

 

 

1 Supported on WINGHEAD X Long Range, WINGHEAD B51S Long Range and WINGHEAD i80S Long Range models only. 

 

http://192.168.53.xx:8080/
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B2. Additional SIU COM Ports 

Integrated systems contain one SIU COM port for receiving GNSS corrections and/or GNSS/INS output 
to external systems. For additional ports, a split serial upgrade option is available, which includes the 
split cable plus a factory SIU modification. The cable connects to the SIU COM port and splits into 2 or 
3 labelled connectors: COM1/A, COM2/B and COM3/C. 

 

Integrated GNSS/INS Cable Part Number Configurable Ports 

Applanix AP+ 33424 COM1, COM3 

Applanix (Legacy) 33209 COM1, COM2, COM3 

SBG 33209 Port A, Port B, Port C 

 
 

⚠ 
CAUTION: The serial split option includes an internal hardware modification, 
which means the SIU COM port is no longer a standard serial port. No cables, 
other than the split serial cable provided by NORBIT, should be connected. 

 
 

Integrated Applanix AP+ Systems 

Step 1. For AP+ systems, only one additional port (COM1) is configurable 
through the AP+ Web UI at: http://192.168.53.100 

Step 2. Go to the I/O Configuration menu. The port configured on the last 
page of the INS Setup Wizard corresponds to COM3, therefore only 
COM1 should be configured through the Web UI. 

Step 3. Select the output type (NMEA or Binary), messages and baud rate, 
and click OK. COM2 must NOT be changed. If additional outputs 
are required, network outputs can be configured. 

Integrated Applanix (Legacy) Systems 

Step 1. Use the correct version of POSView that matches the INS firmware. 
Click Connect and go to Settings > Input/Output Ports… 

Step 2. The port configured on the last page of the INS Setup Wizard 
corresponds to COM3, therefore COM3 can be configured in the 
GUI. For each additional port in POSView (COM1 & COM2), select 
the output type (NMEA or Binary), output messages and baud rate. 

Step 3. Click Apply and Close, then select Settings > Save Settings 

Step 4. Click Monitor, or close POSView, to avoid conflicts with the NORBIT 
GUI. Note that COM4 must NOT be changed. 

Integrated SBG Systems 

Step 1. For systems equipped with SBG hardware, the additional ports are 
configured through the Web UI at: http://192.168.53.103 

Step 2. Set the baud rate under Inputs/Outputs > COM Ports. The port 
configured on the last page of the INS Setup Wizard corresponds 
to Port C in the Web UI, therefore Port C can be configured via the 
GUI, and Ports A and B through the Web UI. 

Step 3. Configure the outputs for Port A & B using the Web UI, under Data 
Output > Port A/Port B. Port D must NOT be changed.  

Connect Monitor 

http://192.168.53.100/
http://192.168.53.103/
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B3. Detached SVP (SVPd) 

The detached SVP option is available for WINGHEAD users that require an external, field-swappable, 
AML sound velocity sensor that can be removed underwater by divers. It is supported out of the box and 
there are no special software requirements. 

 

Hardware Requirements 
• WINGHEAD SVPd sonar variant, containing SVPd bulkhead connector. 

• Optional mounting bracket (PN 35216) 

• AML SV sensor which comprises: 
▪ SV sensor housing (PN 954147) 
▪ Swappable SVT sensor (PN 954145) 
▪ AML SV cable with 50cm length standard, 2m optional (PN 33300) 

 

Connection Details 
• The AML SVPd connects to the 10-pin connector on the sonar using cable PN 33300. The pinout 

details are provided below: 
 

Probe Sonar Function 

1 1 RS232 to Probe 

2 5 Signal & PWR GND 

3 6 12/24 vDC 

4 2 RS232 from Probe 

 

Supported Probes 
• All AML SV sensors are supported, except for salinity sensors on the AML-1. 

 

Mounting 
• The sensor is mounted using the supplied bracket (PN 35216) that attaches to the standard 

WINGHEAD mounting bracket (PN 35150). 

• The regular nuts on the bracket are swapped with extended nuts that allows the SVPd bracket to be 
attached. Note that the bracket is not compatible with WINGHEAD S-series models. 

 

 

No. Part Number Description Torque Qty 

1 451521 Clamp Bracket 5 Nm 1 

2 DIN 912 M6x25 --- 25C M6 Screws - 2 

3 451522 Extended Bracket Nut, M6 5 Nm 2 
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B4. Backscattering Strength Output 

Backscattering Strength Output (BSO) is an optional upgrade that provides backscatter strength output, 
demonstrating how strong, in absolute form, the bottom reflects transmitted acoustic signals. It 
provides fully repeatable backscatter results, as well as compatibility with physical models. 

 

Requirements 

• The unit must be calibrated at NORBIT’s production facility. Each calibration is unit-specific and 
cannot be shared with other sonars. It is not performed as standard with new systems. 

• In addition to the calibration file, a valid BSO license is required (see Appendix B1). 
 

Applying the Calibration 

1. Copy the supplied XML calibration file from the USB stick to this directory on the GUI PC, ensuring 
that the filename is correct: %appdata%\Norbit\CalibrationFiles\CalBSSdata.xml 

2. Apply the BSO license to the sonar using the procedure described in Appendix B1. 
3. With both a valid license and BSO calibration file, the sonar can now generate 7k record 7058 

containing backscattering strength snippet data. 
4. The 7058 record is available for TCP subscription from the GUI and is also saved in the s7k files 

when raw data recording is activated in the GUI. 

Sonar Settings 
• Correct TVG settings under Backscatter Controls are essential: 

o Static Gain: Set to 0 by default 
o Spreading: Should be set to 40. 
o Absorption: Set to the correct physical value for the 

current environment. 

• All applied TVG settings are reported in the s7k datagrams. 

• If required, WBM files can be reprocessed with different TVG 
parameters and re-exported to s7k (see section 4.8.6.5). 

 
The graph below provides approximate values only. For accurate values, enable Use calculated 
absorption, or use this calculator: http://resource.npl.co.uk/acoustics/techguides/seaabsorption/ 
 

 

http://resource.npl.co.uk/acoustics/techguides/seaabsorption/
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Appendix C: Hardware Dimensions & Offsets 
C1. WINGHEAD X (PN 24116/24119) 

WINGHEAD X WINGHEAD X Long Range 
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Sonar PN: 24116 
Weight: 6.9kg (air), 3.7kg (water) 

4 x 90° 
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IMU Ref* 
(see Appendix F) 

Sonar Ref. 
Top Centre Bracket 
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Sonar PN: 24119 
Weight: 8.0kg (air), 4.2kg (water) 

4 x 90° 

2
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2
7

 

1
1
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Top Centre Bracket Sonar Ref. 

IMU Ref* 
(see Appendix F) 

Ø550 
 

Ø470 
  

Recommended minimum internal diameter with 
centre of sonar bracket in centre of moonpool. 

Recommended minimum internal diameter 
with sonar mounted off-centre in moonpool. 

Moonpool Dimensions 

*Relevant for integrated models only. 
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C2. WBMS X (PN 24216) 

Including Mounting Bracket Excluding Mounting Bracket 
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Top Centre Bracket 
Sonar Ref. 

IMU Ref* 
(see Appendix F) 

102 
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8
 

236 

Weight     In Air  In Water 
iWBMS Xh    6.7kg  3.3kg 
iWBMS X    6.6kg  3.2kg 
iWBMS Xe    6.5kg   3.1kg 
iWBMS X Ekinox  6.5kg  3.1kg 
WBMS X    6.2kg  2.8kg 
Bracket     0.5kg   0.4kg 

Ø410 Ø360 
  

Recommended minimum internal diameter with 
centre of sonar bracket in centre of moonpool. 

Recommended minimum internal diameter 
with sonar mounted off-centre in moonpool. 

Moonpool Dimensions 

*Relevant for integrated models only. 
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C3. WINGHEAD i77h / i79h / B41 / B43 (PN 24103) 

Excluding Mounting Bracket 

 

Including Mounting Bracket 

 
 

447 

1
0
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Weight: 
B41 : 6.6kg (air), 3.5kg (water) 
B41 Titan : 9.0kg (air), 5.9kg (water) 
B43 : 9.0kg (air), 5.9kg (water) 
i77h : 6.9kg (air), 3.6kg (water) 
i79h : 9.3kg (air), 6.2kg (water) 
 

1
0

2
 

1
1

1
 

Sonar Ref. Point 
Top Centre Bracket 
IMU Ref. Point* 
(see Appendix F) 

*Relevant for integrated models only. 

2
9

6
 

447 

M10 Thread 
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4 x 90° 

154 Bracket Mounting Pattern – Pole Mount 

Bracket Mounting Pattern – Hull Mount 

1
2

9
 

Weight: 
B41 :  8.1kg (air), 4.7kg (water) 
B41 Titan :  10.5kg (air), 7.1kg (water) 
B43 :  10.5kg (air), 7.1kg (water) 
i77h :   8.4kg (air), 5.0kg (water) 
i79h :  10.8kg (air), 7.4kg (water) 
  

2
9

 
2

7
 

1
1

1
 

1
0

2
 

 
2

9
6

 
 

Sonar Ref. Point 
Top Centre Bracket 
IMU Ref. Point* 
(see Appendix F) 
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WINGHEAD i77h/i79h-Apogee 
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M10 Thread 
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4 x 90° 
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Weight: 
8.5kg (air), 5.2kg (water) 
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446 

9
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Ø560 
Ø480 

894.9 

1
2

2
.8

* 

* Bracket centre to centre of moonpool 

Recommended minimum internal 
diameter with centre of sonar 

bracket in centre of moonpool. 

Recommended minimum internal 
diameter with sonar mounted off-

centre in moonpool. 

Recommended minimum 
internal diameter with dual head 

system in standard bracket. 

Centre of sonar bracket off-centre of moonpool 
Centre of sonar bracket in centre in moonpool Also valid for WINGHEAD i77h/i79h-Apogee models. 

Moonpool Dimensions 

Sonar Ref. Point 
Top Centre Bracket 
IMU Ref. Point* 
(see Appendix F) 
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C4. WINGHEAD B51S / i80S / i80S LR (PN 24115/24119) 

 

WINGHEAD B51S WINGHEAD i80S / WINGHEAD i80S-Apogee 

  
 

WINGHEAD B51S/i80S Long Range  
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447 159 

Sonar PN: 24115 
Weight: 6.7kg (air), 3.0kg (water) 
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Sonar PN: 24115 
Weight: 11.0kg (air), 4.9kg (water) 
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Sonar PN: 24119 
Weight: 8.0kg (air), 4.2kg (water) 

4 x 90° 
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Sonar Ref. Point 
Top Centre Bracket 
IMU Ref. Point* (see Appendix F) 

*Relevant for integrated models only. 
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C5. WINGHEAD B44 Deep Sea (PN 24110) 

Excluding Mounting Bracket 

 

Including Mounting Bracket 

 

447 

1
0

3
 

Weight: 
B44 : 10.8kg (air), 7.1kg (water) 
 

CAUTION: The vent screw beneath the sonar allows controlled pressure release after deep dives in case of 
suspected leaks. Do NOT tamper with it. Contact NORBIT Support for guidance if in doubt. 
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C6. WINGHEAD Fairing (PN 35166) 

 

C7. IMU Detached (IMUd, PN 24036) 

 

1
0

2
 

Assembly Instructions: 
1. Place fairing onto sonar. 
2. Attach 4x M6x55mm screws through sonar. 
3. Torque to 1Nm after all bolts are aligned. 

Weight: 0.9kg 

Part No. Description Qty 

451280 WINGHEAD Fairing Bumper 1 

- DIN 912 M6 x 55 – 24N 4 
 

44 
448 

• For through-hole mounting, use M5 countersunk bolts. 
• For direct attachment, use M6 bolts. 

Note: The IMUd has a depth rating of 50m. 

The IMU Reference Point is offset from the IMU Target marked on the top. The offsets and mounting angles 
are based on the default orientation (connector forward/port, X-axis  forward, and Y-axis starboard). 

IMU Type Part No. IMU Target to IMU Ref. Point IMU Mounting Angles 

  X +Fwd Y +Stbd Z +Down X Y Z 

Type 82/89 24036-P2/P3 0.000 m 0.000 m 0.052 m 0.00° 0.00° 0.00° 

Type 90 24036-P9 -0.005 m 0.000 m 0.075 m 0.00° 0.00° 90.00° 

Type 94 24036-P4 -0.005 m 0.004 m 0.065 m 0.00° 0.00° 180.00° 

Type 69 24036-P1 0.001 m -0.015 m 0.076 m 0.00° 0.00° -90.00° 

Apogee 24036-PA 0.001 m 0.013 m 0.056 m 0.00° -90.00° 0.00° 

Ekinox 24036-PE -0.002 m -0.014 m 0.080 m 0.00° 0.00° -90.00° 
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IMU Target IMU Ref. Point 

IMU Target 

 
  

  

X +Fwd 

Y +Stbd Z +Down 

Y +Stbd X +Fwd 

Z +Down 
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C8. Sonar Interface Unit 

Integrated iSIU 

 
Note: The INS LEDs at the top of the SIU vary by model. Refer to section 2.3.4. 

 

Non-Integrated SIU 

PN 29064 
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PN 29093: Applanix AP+  |  PN 29060: Applanix AP           PN 29088: SBG 
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TN-240293  83 

 

 CABLES & CONNECTORS   

Appendix D: Cables & Connectors 
 

⚠ 
CAUTION: Several cable types appear visually similar but are not cross-compatible. 
Confirm the sonar connector type before connecting a cable and use only the original 
parts supplied with your system to ensure reliability and warranty coverage. 

 
 

D1. Connector Identification 

NORBIT sonars use 3 bulkhead connectors: 18-pin 318R, 18-pin 318E, and 24-pin. The connector type 
on your unit determines which cable and pinout information applies. Identify your connector visually 
using the images below. 
 

318R Connector (18-pin) 318E Connector (18-pin) 24-pin Connector 

    

Used on all WINGHEAD X and 
WBMS X models, and on most 
current WINGHEAD systems. 

Still supported on several 
WINGHEAD models in the field. 

Used on early revisions of depth-
rated WINGHEAD models. 

 

D2. Cable Options for 18-pin 318R Connector (Current Standard) 

D2a.  Integrated iSIU Cable (PN 33371) 
Description: Connects the Integrated iSIU to sonars which contain the 18-pin 318R bulkhead connector. 

 
 

Subsea 
(18-pin) 

Topside 
(18-pin) 

Function 

1 3 PWR+ 

2 7 ETH1_A+ 

3 12 ETH1_A- 

4 4 PWR+ 

5 5 IMU_A+ 

6 9 TIME+ 

7 14 TIME- 

8 10 TIME_GND 

9 18 IMU_C- 

10 6 IMU_A- 

11 11 Trigger_GND 

12 16 TRIGGER- 

13 15 TRIGGER+ 

14 17 IMU_C+ 

15 1 GND 

16 8 ETH1_B+ 

17 13 ETH1_B- 

18 2 GND 

OD 25mm 

OD 18mm 

Cable ⌀ 10.5mm 

18 pin Subsea connector 

18 pin Lemo 
connector 

Angled 
Option 

Straight 
Option 
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D2b.  Non-Integrated SIU Cable (PN 33372) 
Description: Connects the Non-Integrated SIU to sonars which contain the 18-pin 318R bulkhead connector. 

 
 
 
 

D2c.  Integrated iSIU Split Cable (PN 33373) 
Description: Connects the Integrated iSIU to models which contain separate 8-Pin IMU (308E) and 18-pin sonar 
(318R) bulkhead connectors. 

 

 
 
 
 
 

Subsea 
(18-pin) 

Topside 
(10-pin) 

Function 

1 10 PWR+ 

2 1 ETH1_A+ 

3 2 ETH1_A- 

4 10 PWR+ 

5 N/C - 

6 7 TIME+ 

7 8 TIME- 

8 N/C - 

9 N/C - 

10 N/C - 

11 N/C - 

12 6 Trigger- 

13 5 Trigger+ 

14 N/C - 

15 9 GND 

16 3 ETH1_B+ 

17 4 ETH1_B- 

18 9 GND 

Topside 
(18-pin) 

Subsea 
Function 

18-pin 8-pin 

1 15 4 GND 

2 18 4 GND 

3 1 3 24 VDC 

4 4 3 24 VDC 

5 - 8 IMU COM1 

6 - 7 IMU COM2 

7 2 - ETH1_A+ 

8 16 - ETH1_B+ 

9 6 - TIME+ 

10 - 6 IMU COM3 

11 - 5 IMU COM4 

12 3 - ETH1_A- 

13 17 - ETH1_B- 

14 7 - TIME- 

15 13 - Trigger+ 

16 12 - Trigger- 

17 - 2 IMU COM8 

18 - 1 IMU COM9 

OD 25mm 

OD 18mm 

Cable ⌀ 9.5mm 

OD 25mm 

OD 25mm 

OD 18mm 

Cable ⌀ 9.5mm 

 
 

Cable ⌀ 10.5mm 

 

1
0

0
m

m
 

 

⌀
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5
m

m
 

 

6
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m
m

 

Angled 
Option 

Straight 
Option 

18 pin Subsea connector 

10 pin Lemo 
connector 



 

 
 
 

 

TN-240293  85 

 

 CABLES & CONNECTORS   

D2d.  Subsea Sonar Interface Pigtail (PN 33370) 
Description: ROV/AUV pigtail to interface with sonars which contain the 18-pin 318R bulkhead connector. 

 

 
 
 
 

D3. Cable Options for 18-pin 318E Connector (Legacy) 

D3a.  Integrated iSIU Cable (PN 33231) 
Description: Connects the Integrated iSIU to sonars which contain the 18-pin 318E bulkhead connector. 

 
 

 

Pin Function Colour 

1 PWR+ White 

2 ETH1_A+ Black (red pair) 

3 ETH1_A- Red 

4 PWR+ White 

5 IMU_A+/ETH1_C+ Orange 

6 TIME+ Brown 

7 TIME- Black (brown pair) 

8 TIME_GND Drain wire 

9 IMU_C-/ETH1_D- Black (green pair) 

10 IMU_A-/ETH1_C- Black (orange pair) 

11 Trigger_GND Drain wire 

12 Trigger- Black (white pair) 

13 Trigger+ White 

14 IMU_C+/ETH1_D+ Green 

15 GND Black 

16 ETH1_B+ Blue 

17 ETH1_B- Black (blue pair) 

18 GND Black 

Subsea 
(18-pin) 

Topside 
(18-pin) 

Function 

1 1 GND 

2 2 GND 

3 3 24 VDC 

4 4 24 VDC 

5 5 IMU COM1 

6 6 IMU COM2 

7 7 LAN, TX+ 

8 8 LAN, RX+ 

9 9 IRIG-B+ 

10 10 IMU COM3 

11 11 IMU COM4 

12 12 LAN, TX- 

13 13 LAN, RX- 

14 14 IRIG-B- 

15 15 Trigger+ 

16 16 Trigger- 

17 17 N/C 

18 18 N/C 

OD 25mm 

OD 18mm 

Cable ⌀ 10.5mm 

OD 25mm 

Cable ⌀ 10.5mm 
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D3b.  Non-Integrated SIU Cable (PN 33248) 
Description: Connects the Non-Integrated SIU to sonars which contain the 18-pin 318E bulkhead connector. 

 
 

 

D3c.  Integrated iSIU Split Cable (PN 33273) 
Description: Connects the Integrated iSIU to models which contain separate 8-Pin IMU (308E) and 18-pin sonar 
(318E) bulkhead connectors. 

 
 

 
 

Subsea 
(18-pin) 

Topside 
(10-pin) 

Function 

1 9 GND 

2 9 GND 

3 10 24 VDC 

4 10 24 VDC 

5 N/C - 

6 N/C - 

7 1 LAN, TX+ 

8 3 LAN, RX+ 

9 7 IRIG-B+ 

10 N/C - 

11 N/C - 

12 2 LAN, TX- 

13 4 LAN, RX- 

14 8 IRIG-B 

15 5 Trigger+ 

16 6 Trigger- 

17 N/C - 

18 N/C - 

Topside 
(18-pin) 

Subsea 
Function 

18-pin 8-pin 

1 1 4 GND 

2 2  GND 

3 3 3 24 VDC 

4 4 - 24 VDC 

5 - 8 IMU COM1 

6 - 7 IMU COM2 

7 7 - LAN, TX+ 

8 8 - LAN, RX+ 

9 9 - IRIG-B+ 

10 - 6 IMU COM3 

11 - 5 IMU COM4 

12 12 - LAN, TX- 

13 13 - LAN, RX- 

14 14 - IRIG-B- 

15 15 - Trigger+ 

16 16 - Trigger- 

17 - 2 IMU COM8 

18 - 1 IMU COM9 

OD 25mm 

OD 18mm 

Cable ⌀ 9.5mm 

OD 25mm 

OD 25mm 

OD 18mm 

Cable ⌀ 9.5mm 

 
 

Cable ⌀ 10.5mm 

 

1
0

0
m

m
 

 

⌀
3

5
m

m
 

 

6
0

m
m
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D3d.  Subsea Sonar Interface Pigtail (PN 33272) 
Description: ROV/AUV pigtail to interface with sonars which contain the 18-pin 318E bulkhead connector. 

 
 

D4. Cable Options for 24-pin Connector (Legacy) 

D4a.  Integrated iSIU Cable (PN 33228) 
Description: Connects the Integrated iSIU to sonars which contain the 24-pin bulkhead connector. 

 
 

 

 

 

Pin Function Colour 

1 GND Black 

2 GND Black 

3 24 VDC White 

4 24 VDC White 

5 N/C - 

6 N/C - 

7 LAN, TX+ White/Orange 

8 LAN, RX+ White/Green 

9 IRIG-B+ White/Blue 

10 N/C - 

11 N/C - 

12 LAN, TX- Orange 

13 LAN, RX- Green 

14 IRIG-B- Blue 

15 Trigger+ White/Brown 

16 Trigger- Brown 

17 N/C - 

18 N/C - 

Subsea 
(24-pin) 

Topside 
(18-pin) 

Function 

1 9 TIME+ 

2 14 TIME- 

3 N/C - 

4 1 PWR- 

5 13 ETH_B- 

6 8 ETH_B+ 

7 2 PWR- 

8 7 ETH_A+ 

9 5 IMU_A+ 

10 11 IMU_B- 

11 17 IMU_C+ 

12 N/C - 

13 12 ETH_A- 

14 6 IMU_A- 

15 10 IMU_B+ 

16 18 IMU_C- 

17 N/C - 

18 3 PWR+ 

19 N/C - 

20 N/C - 

21 4 PWR+ 

22 N/C - 

23 16 TRIG- 

24 15 TRIG+ 

Cable ⌀ 10.5mm 

OD 25mm 

STRAIGHT CONNECTOR 

Available in 2m and 8m lengths. 

OD 30mm 

OD 18mm 

Cable ⌀ 10.5mm 
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D4b.  Non-Integrated SIU Cable (PN 33267) 
Description: Connects the Non-Integrated SIU to sonars which contain the 24-pin bulkhead connector. 

 
 

 

 

D4c.  Subsea Sonar Interface Pigtail (PN 33256) 
Description: ROV/AUV pigtail to interface with sonars which contain the 24-pin bulkhead connector. 

 
 

Subsea 
(24-pin) 

Topside 
(10-pin) 

Function 

1 7 TIME+ 

2 8 TIME- 

3 N/C - 

4 9 PWR- 

5 4 ETH_B- 

6 3 ETH_B+ 

7 9 PWR- 

8 1 ETH_A+ 

9 N/C - 

10 N/C - 

11 N/C - 

12 N/C - 

13 2 ETH_A- 

14 N/C - 

15 N/C - 

16 N/C - 

17 N/C - 

18 10 PWR+ 

19 N/C - 

20 N/C - 

21 10 PWR+ 

22 N/C - 

23 6 TRIG- 

24 5 TRIG+ 

Pin Function Comment 

1 TIME+ TTL/RS422 

2 TIME- TTL/RS422 

3 TIME_GND TTL/RS422 

4 PWR- PWR GND 

5 ETH_B- 1000BASE-T 

6 ETH_B+ 1000BASE-T 

7 PWR- PWR GND 

8 ETH_A+ 1000BASE-T 

9 IMU_A+ RS422 

10 IMU_B- RS422 

11 IMU_C+ RS422 

12 ETH_C- 1000BASE-T 

13 ETH_A- 1000BASE-T 

14 IMU_A- RS422 

15 IMU_B+ RS422 

16 IMU_C- RS422 

17 ETH_C+ 1000BASE-T 

18 PWR+ 24-48VDC 

19 ETH_D+ 1000BASE-T 

20 ETH_D- 1000BASE-T 

21 PWR+ 24-48VDC 

22 TRIG_GND TTL/RS422 

23 TRIG- TTL/RS422 

24 TRIG+ TTL/RS422 

OD 30mm 

OD 30mm 

OD 18mm 

Cable ⌀ 9.5mm 

Cable ⌀ 10.5mm 
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D4d.  Subsea Sonar Interface Cable (PN 33264) 
Description: ROV/AUV interface cable for vehicle integrators, with Titanium depth-rated connectors on both ends, 
for sonars which contain the 24-pin bulkhead connector. 

 

 
 

 

 

D5. IMU Detached (IMUd) Cable (PN 33172) 

Description: Connects the Integrated iSIU (via the Sonar Port) to the IMUd (PN 24036) 8-Pin connector. 

 

 

   

 

Subsea 
(24-pin) 

Topside 
(10-pin) 

Function 

1 7 TIME+ 

2 N/C - 

3 8 TIME_GND 

4 9 PWR- 

5 4 ETH_B- 

6 3 ETH_B+ 

7 9 PWR- 

8 1 ETH_A+ 

9 N/C - 

10 N/C - 

11 N/C - 

12 N/C - 

13 2 ETH_A- 

14 N/C - 

15 N/C - 

16 N/C - 

17 N/C - 

18 10 PWR+ 

19 N/C - 

20 N/C - 

21 N/C - 

22 6 TRIG_GND 

23 N/C - 

24 5 TRIG+ 

Topside 
(18-pin) 

Subsea 
(8-pin) 

Function 

1 4 IMU GND 

2 - - 

3 3 IMU 24 VDC 

4 - - 

5 8 IMU COM1 

6 7 IMU COM2 

7 - - 

8 - - 

9 - - 

10 6 IMU COM3 

11 5 IMU COM4 

12 - - 

13 - - 

14 - - 

15 - - 

16 - - 

17 2 IMU COM8 

18 1 IMU COM9 

OD 30mm 

OD 18mm 

Cable ⌀ 9.5mm 

OD 25mm 

OD 18mm 

Cable ⌀ 10.5mm 
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D6. Sonar Bulkhead Connectors & Pinouts 

All connectors: 600 bar depth rating (mated), 300V contact rating, >5000 cycles endurance (IEC 60512-5 test 9a) 

 

PN 33362/33360, 318R Connector 

(Current Standard) 

 

 
 

 
 
 
 

Pin Function 

1 PWR+ 

2 ETH1_A+ 

3 ETH1_A- 

4 PWR+ 

5 IMU_A+/ETH1_C+ 

6 TIME+ 

7 TIME- 

8 TIME_GND 

9 IMU_C-/ETH1_D- 

10 IMU_A-/ETH1_C- 

11 Trigger_GND 

12 Trigger- 

13 Trigger+ 

14 IMU_C+/ETH1_D+ 

15 GND 

16 ETH1_B+ 

17 ETH1_B- 

18 GND 

  

PN 33237, 318E Connector (Legacy) 

 
 

 
 

Pin Function 

1 GND 

2 GND 

3 24 VDC 

4 24 VDC 

5 IMU COM1 

6 IMU COM2 

7 LAN, TX+ 

8 LAN, RX+ 

9 IRIG-B+ 

10 IMU COM3 

11 IMU COM4 

12 LAN, TX- 

13 LAN, RX- 

14 IRIG-B- 

15 Trigger+ 

16 Trigger- 

17 IMU COM8 

18 IMU COM9 

PN 33227, 24-pin Connector (Legacy) 

 
 

Pin Function 

1 TIME+ 

2 TIME- 

3 TIME_GND 

4 PWR- 

5 ETH_B- 

6 ETH_B+ 

7 PWR- 

8 ETH_A+ 

9 IMU_A+ 

10 IMU_B- 

11 IMU_C+ 

12 ETH_C- 

13 ETH_A- 

14 IMU_A- 

15 IMU_B+ 

16 IMU_C- 

17 ETH_C+ 

18 PWR+ 

19 ETH_D+ 

20 ETH_D- 

21 PWR+ 

22 TRIG_GND 

23 TRIG- 

24 TRIG+ 

  

15 

4 

9 

14 

5 

10 

1 (Pin) 

O-ring type: Parker 2-014 
NBR 70 Ø12.42x1.78 

18 (Socket) 

O-ring type: Parker 2-014 
NBR 70 Ø12.42x1.78 

15 

4 

9 

14 

5 

10 

18 (Socket) 

1 (Pin) 

1 
(So

3 (Socket) 

4 

8 

13 

18 

22 
(Pi

24 (Pin) 

21 

17 

12 

7 

O-ring type: Parker 6-725 
NBR 70 Ø16.56x1.78 

Note: Any NBR 70 ⌀16.56 x 1.78mm 

O-ring can be used. 
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 CABLES & CONNECTORS   

D7. Sonar Interface Unit Connectors & Pinouts 

 

Integrated iSIU 

PN 29093: Applanix AP+ | PN 29060: Applanix AP | PN 29088: SBG 

 

Non-Integrated SIU 

PN 29064 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

   

 

   

 

Sonar Socket 

Pin Function 

1 GND 

2 GND 

3 24 VDC 

4 24 VDC 

5 IMU COMM1 

6 IMU COMM2 

7 LAN, TX+ 

8 LAN, RX+ 

9 Time Out 

10 IMU COMM3 

11 IMU COMM4 

12 LAN, TX- 

13 LAN, RX- 

14 Signal GND 

15 Trig+ (RS422) 

16 Trig- (RS422) 

17 IMU COMM8 

18 IMU COMM9 

 AUX Socket 

Pin Function 

1 LAN TX+ 

2 LAN TX - 

3 LAN RX+ 

4 LAN RX- 

5 Trig- (RS422) 

6 Trig+ (RS422) 

7 Time Out 

8 Signal GND 

9 PWR GND 

10 PWR + 24 VDC 

 
12-28 VDC Socket 

Pin Function 

1 PWR GND 

2 PWR+12-28 VDC 

 
COM Socket / BNC 

Pin Function 

2 INS COM3 RX 

3 INS COM3 TX 

5 GND 

9/BNC PPS Out 

 

COM Socket / BNC 

Pin Function 

2 ZDA In, RS232 RX 

3 RS232 TX 

5 GND 

9/BNC PPS In 

 

12-28 VDC Socket 

Pin Function 

1 PWR GND 

2 PWR+12-28 VDC 

 

AUX Socket 

Pin Function 

1 NC 

2 NC 

3 NC 

4 NC 

5 Trig- (RS422) 

6 Trig+ (RS422) 

7 NC 

8 Signal GND 

9 NC 

10 NC 

 

Sonar Socket 

Pin Function 

1 LAN TX+ 

2 LAN TX - 

3 LAN RX+ 

4 LAN RX- 

5 Trig+ (RS422) 

6 Trig- (RS422) 

7 Time Out 

8 Signal GND 

9 PWR GND 

10 PWR + 24 VDC 
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 MOUNTING HARDWARE  

Appendix E: Mounting Hardware 
E1. WINGHEAD Detached IMU (IMUd) Mounting Bracket (PN 451314) 

 

 

E2. WINGHEAD Multi-Purpose Bracket (PN 451547) 

 

 

95.2 

15 

3
1

7
.7

 

Weight: 0.7kg 

9
5

.2
 

8
7

.2
 

8
3

.5
 

8
.3

 

38.3 

76.5 

0.5mm depth 
1mm width 

4 x Ø10.5 Thru 

4 x Ø6.6 Thru All 
 Ø13.4 x 90° 

47.6 

3
5

 

120 

0
 

2
0

 

8
0

 

1
0

2
.5

1
 

1
5

6
 

1
9

7
.7

0
 

2
1

6
 

2
3

8
.8

0
 

3
2

5
.0

1
 

3
5

6
.6

0
 

4
0

0
.6

0
 

4
2

0
.2

0
 

5
2

5
.0

1
 

5
6

5
.6

0
 

6
0

0
.6

0
 

6
2

0
.2

0
 

6
3

7
.6

0
 

1
5

 

130 

112.60 

65 

17.41 
0 

Ø10.50 x 12 pcs. 

Stainless steel bracket for dual head i80S/B51S in fore/aft configuration. 
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 MOUNTING HARDWARE  

E3. Dual Head WINGHEAD Bracket (PN 35163) 

 

 

 

Sonar Ref. Point 
Top Centre Bracket Top Centre Dual Head Bracket 

IMU Ref. Point 

* 
2

7
 

5 

* 

221 3
8

 

3
8

 
2

7
 

29 
* 

* 

301 

1
7

2
 

1
° 

895 

36 

5
9

 

5
0

 
221 221 

5
9

 

36 

570 

4 x Ø10.5 Thru All 

4 x Ø10.5 Thru All 

8 x M10x40 

Weight: 
i77h :19.9kg (air), 9.4kg (water) 
B41 : 19.6kg (air), 8.8kg (water) 
  

* IMU Ref. Point offset varies depending on the integrated IMU type. Refer to Appendix F. 
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 MOUNTING HARDWARE  

E4. Dual Head WBMS X Bracket (PN 452255) 

 

381 

4
0

 

Mount the sonars (and PORTUS pole, when 
used) in the direction of these marks 

Max. torque M6 
bolts: 3Nm 

Secure the cable in these 
grooves. Max nominal 
diameter Ø10.50 

1
8

9
 

Max. torque 
M10 bolts: 8Nm 

No. Part Qty 

1 452255 1 

2 Screw ISO4762 M10-40-A4 8 

3 Washer DIN125 M10-A4 16 

4 Washer DIN127 M10-A4 12 

5 Screw ISO4762 M6-25-A4 4 

6 Screw ISO4762 M10-60-A4 4 

7 Propower cable cleat_NP0620 4 

8 Nut DIN985 M10-A4 4 

 

Dimensions 

Mounting 

Refer to Appendix F2 for sonar offsets. 

F
o

rw
a

rd
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 MOUNTING HARDWARE  

E5. NORBIT Carbon Fibre PORTUS Mounting Pole MKIII 

 

Ant 2 Ant 1 Auxiliary Antenna 
(optional) 

0.510m 

1.046m 0.955m 

0.050m 
(Min) 

0.190m 

0.031m 

Standard: 1.700m (Max) 
Optional: 
+ Half Foil: 2.630m 
+ Full Foil: 3.560m 

Standard: 1.978m 
Optional: 
+ Half Foil: 2.908m 
+ Full Foil: 3.838m 

3.632m (Max Extension) 
2.887m (Mid Extension) 
2.137m (Min Extension) 

Bottom of PORTUS Flange 

T
e

le
s

c
o

p
ic

 

Standard Foil Case Dimensions – with case and all hardware 

Length: 200cm / 79” | Width: 33cm / 13” | Depth: 25cm / 10” | Total Weight: 27kg / 60lbs 

A 

Detail A – Gunwhale Plate 

0
 

2
5

 

5
0

 

1
2

5
 

1
4

0
 

1
9

2
 

2
0

5
 

2
9

5
 

3
0

8
 

3
6

0
 

3
7

5
 

4
5

0
 

4
7

5
 

5
0

0
 

0 
8 

25 
26 

52 

142 

168 
169 
186 
194 

1
0

 

8 x Ø6.60 Thru All 
 Ø13.71 x 90° 

 

Weight: 1.9kg 

iLiDAR Ref. 



 

 
 
 

 

TN-240293  96 

 

 IMU MOUNTING ANGLES & OFFSETS   

Appendix F: IMU Mounting Angles & Offsets 
 
 

ⓘ 
NOTE: For systems with integrated GNSS/INS subsystems, the relevant offsets are 
automatically detected in the INS Setup Wizard. Therefore, knowledge of the IMU offset 
and internal mounting angles is not required. They are presented below for reference. 

 
 
 

 

F1. WINGHEAD X 

Single Head Configurations 

Sonar Kit 
(Drawings: Appendix C) 

IMU Type1 Sonar Ref to IMU Ref IMU Angles 
Sonar Ref to 

Top Centre of Bracket 

WINGHEAD X 

Applanix 
Type 94 

+Fwd: 0.109 m 
+Stbd: 0.003 m 
+Down: 0.035 m 

X: 90⁰ 
Y: 0⁰ 
Z: 90⁰ +Fwd: 0.029 m 

+Stbd: 0.000 m 
+Down: -0.027 m Applanix 

Type 89 

+Fwd: 0.096 m 
+Stbd: 0.000 m 
+Down: 0.040 m 

X: 0⁰ 
Y: -90⁰ 
Z: 180⁰ 

 
 

Dual Head Configurations (Bracket PN 35163 with IMU installed on the port side)2 

Sonar Kit 
(Drawings: Appendix C) 

IMU Type1 Sonar Ref to IMU Ref IMU Angles 
Sonar Ref to Top Centre 

of Dual Head Bracket 
Primary to 

Secondary Offset 

WINGHEAD X 

Applanix 
Type 94 

+Fwd: 0.109 m 
+Stbd: -0.006 m 
+Down: 0.034 m 

X: 89⁰ 
Y: -10⁰ 
Z: 90⁰ +Fwd: 0.029 m 

+Stbd: 0.226 m 
+Down: -0.064 m 

+Fwd: 0.000 m 
+Stbd: 0.452 m 
+Down: 0.000 m Applanix 

Type 89 

+Fwd: 0.096 m 
+Stbd: -0.007 m 
+Down: 0.039 m 

X: 96⁰ 
Y: -100⁰ 
Z: 84⁰ 

 

 

1 Type 94/89 refers to the Applanix OceanMaster grade IMU (displayed under INS Tools > System Status). 
2 The dual head bracket (PN 35163) is shown in Appendix E3. For custom arrangements (e.g. different rotation angles, or IMU installed 

on the starboard side) please consult the technical note TN-190018. Contact NORBIT Support if you require this document. 
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 IMU MOUNTING ANGLES & OFFSETS   

F2. WBMS X 

Single Head Configurations 

Sonar Kit 
(Drawings: Appendix C) 

IMU Type1 Sonar Ref to IMU Ref IMU Angles 
Sonar Ref. to 

Top Centre of Bracket 

iWBMS Xh 

Applanix 
Type 94 

+Fwd: 0.109 m 
+Stbd: 0.003 m 
+Down: 0.035 m 

X: 90⁰ 
Y: 0⁰ 
Z: 90⁰ 

+Fwd: 0.029 m 
+Stbd: 0.000 m 

+Down: -0.027 m 

Applanix 
Type 89 

+Fwd: 0.096 m 
+Stbd: 0.000 m 
+Down: 0.040 m 

X: 0⁰ 
Y: -90⁰ 
Z: 180⁰ 

iWBMS X 
Applanix 
Type 90 

+Fwd: 0.119 m 
+Stbd: -0.012 m 
+Down: 0.035 m 

X: 0⁰ 
Y: -90⁰ 
Z: 180⁰ 

iWBMS Xe 
Applanix 
Type 69 

+Fwd: 0.123 m 
+Stbd: 0.000 m 
+Down: 0.041 m 

X: 0⁰ 
Y: -90⁰ 
Z: 180⁰ 

iWBMS X Ekinox 
SBG 

Ekinox 

+Fwd: 0.123 m 
+Stbd: 0.000 m 
+Down: 0.035 m 

X: 0⁰ 
Y: -90⁰ 
Z: 180⁰ 

 
 

Dual Head Configurations (Bracket PN 452255 with IMU installed on the port side)2 

Sonar Kit 
(Drawings: Appendix C) 

IMU Type1 Sonar Ref to IMU Ref IMU Angles 
Sonar Ref to Top Centre 

of Dual Head Bracket 
Primary to 

Secondary Offset 

iWBMS Xh 

Applanix 
Type 94 

+Fwd: 0.109 m 
+Stbd: -0.003 m 
+Down: 0.035 m 

X: 90⁰ 
Y: -10⁰ 
Z: 90⁰ +Fwd: 0.029 m 

+Stbd: 0.131 m 
+Down: -0.055 m 

+Fwd: 0.000 m 
+Stbd: 0.262 m 
+Down: 0.000 m 

Applanix 
Type 89 

+Fwd: 0.096 m 
+Stbd: -0.007 m 
+Down: 0.039 m 

X: 90⁰ 
Y: -100⁰ 
Z: 90⁰ 

iWBMS X 
Applanix 
Type 90 

+Fwd: 0.119 m 
+Stbd: -0.018 m 
+Down: 0.032 m 

X: 90⁰ 
Y: -100⁰ 
Z: 90⁰ 

+Fwd: 0.029 m 
+Stbd: 0.131 m 

+Down: -0.055 m 

iWBMS Xe 
Applanix 
Type 69 

+Fwd: 0.123 m 
+Stbd: -0.007 m 
+Down: 0.040 m 

X: 90⁰ 
Y: -100⁰ 
Z: 90⁰ 

+Fwd: 0.029 m 
+Stbd: 0.131 m 

+Down: -0.055 m 

iWBMS X Ekinox 
SBG 

Ekinox 

+Fwd: 0.123 m 
+Stbd: -0.006 m 
+Down: 0.034 m 

X: -90⁰ 
Y: -10⁰ 
Z: 90⁰ 

+Fwd: 0.029 m 
+Stbd: 0.131 m 

+Down: -0.055 m 

 

 

 

 

1 Applanix OceanMaster: Type 94/89, WaveMaster: Type 90, SurfMaster: Type 69 (displayed under INS Tools > System Status). 
2 The dual head bracket (PN 452255) is shown in Appendix E4. For custom arrangements (e.g. different rotation angles, or IMU installed 

on the starboard side) please consult the technical note TN-190018. Contact NORBIT Support if you require this document. 
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 IMU MOUNTING ANGLES & OFFSETS   

F3. WINGHEAD 

Single Head Configurations 

Sonar Kit 
(Drawings: Appendix C) 

IMU Type1 Sonar Ref to IMU Ref IMU Angles 
Sonar Ref to 

Top Centre of Bracket 

WINGHEAD i77h & i79h 

Applanix 
Type 94 

+Fwd: 0.105 m 
+Stbd: 0.003 m 
+Down: 0.035 m 

X: 90⁰ 
Y: 0⁰ 
Z: 90⁰ 

+Fwd: 0.029 m 
+Stbd: 0.000 m 

+Down: -0.027 m 

Applanix 
Type 89 

+Fwd: 0.092 m 
+Stbd: 0.000 m 
+Down: 0.040 m 

X: 0⁰ 
Y: 90⁰ 
Z: 0⁰ 

SBG 
Apogee 

+Fwd: 0.204 m 
+Stbd: 0.005 m 
+Down: 0.034 m 

X: -90⁰ 
Y: 0⁰ 
Z: 90⁰ 

WINGHEAD i80S 

Applanix 
Type 94 

+Fwd: 0.253 m 
+Stbd: -0.011 m 
+Down: 0.028 m 

X: 55⁰ 
Y: 0⁰ 
Z: 0⁰ 

+Fwd: 0.147 m 
+Stbd: 0.000 m 

+Down: -0.057 m 

Applanix 
Type 89 

+Fwd: 0.248 m 
+Stbd: 0.002 m 
+Down: 0.024 m 

X: -55⁰ 
Y: 0⁰ 
Z: 180⁰ 

SBG 
Apogee 

+Fwd: 0.248 m 
+Stbd: -0.008 m 
+Down: 0.016 m 

X: -90⁰ 
Y: -35⁰ 
Z: -90⁰ 

WINGHEAD i80S LR 

Applanix 
Type 94 

+Fwd: 0.109 m 
+Stbd: 0.003 m 
+Down: 0.035 m 

X: 90⁰ 
Y: 0⁰ 
Z: 90⁰ +Fwd: 0.029 m 

+Stbd: 0.000 m 
+Down: -0.027 m Applanix 

Type 89 

+Fwd: 0.096 m 
+Stbd: 0.000 m 
+Down: 0.040 m 

X: 0⁰ 
Y: -90⁰ 
Z: 180⁰ 

 

Dual Head Configurations (Bracket PN 35163 with IMU installed on the port side)2 

Sonar Kit 
(Drawings: Appendix C) 

IMU Type1 Sonar Ref to IMU Ref IMU Angles 
Sonar Ref to Top Centre 

of Dual Head Bracket 
Primary to 

Secondary Offset 

WINGHEAD i77h & i79h 

Applanix 
Type 94 

+Fwd: 0.105 m 
+Stbd: -0.006 m 
+Down: 0.034 m 

X: 89⁰ 
Y: -10⁰ 
Z: 90⁰ +Fwd: 0.029 m 

+Stbd: 0.226 m 
+Down: -0.064 m 

+Fwd: 0.000 m 
+Stbd: 0.452 m 
+Down: 0.000 m Applanix 

Type 89 

+Fwd: 0.092 m 
+Stbd: -0.007 m 
+Down: 0.039 m 

X: 89⁰ 
Y: 80⁰ 
Z: 89⁰ 

WINGHEAD i80S 

Applanix 
Type 94 

+Fwd: 0.253 m 
+Stbd: -0.005 m 
+Down: 0.028 m 

X: 65⁰ 
Y: -1⁰ 
Z: 0⁰ +Fwd: 0.147 m 

+Stbd: 0.231 m 
+Down: -0.094 m 

+Fwd: 0.000 m 
+Stbd: 0.462 m 
+Down: 0.000 m Applanix 

Type 89 

+Fwd: 0.248 m 
+Stbd: -0.004 m 
+Down: 0.024 m 

X: -65⁰ 
Y: 1⁰ 
Z: 180⁰ 

WINGHEAD i80S LR 

Applanix 
Type 94 

+Fwd: 0.109 m 
+Stbd: -0.006 m 
+Down: 0.034 m 

X: 89⁰ 
Y: -10⁰ 
Z: 90⁰ +Fwd: 0.029 m 

+Stbd: 0.226 m 
+Down: -0.064 m 

+Fwd: 0.000 m 
+Stbd: 0.452 m 
+Down: 0.000 m Applanix 

Type 89 
+Fwd: 0.096 m 

+Stbd: -0.007 m 
+Down: 0.039 m 

X: 96⁰ 
Y: -100⁰ 
Z: 84⁰ 

 

 

1 Type 94/89 refers to the Applanix OceanMaster grade IMU (displayed under INS Tools > System Status). 
2 The dual head bracket (PN 35163) is shown in Appendix E3. For custom arrangements (e.g. different rotation angles, or IMU installed 

on the starboard side) please consult the technical note TN-190018. Contact NORBIT Support if you require this document. 


